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Prerequisites 

Intended Audience 

EFILive Customers using the V8 Scan and Tune Tool software. 

Computer Knowledge 

It is expected that readers have a basic understanding of: 

• The Windows operating system; 

• Starting and using Windows applications; 

• Navigating folders using Windows Explorer. 

Tuning Knowledge 

It is expected that readers have a basic understanding of: 

• Electronic Fuel Injection; 

• Electronic Spark Timing; 

• On Board Diagnostics. 

And enough common sense to understand the following: 

• Make small incremental changes; 

• Only make one change at a time; 

• Evaluate and analyze the results of each change using the Scan Tool 
and/or other data logging devices before making the next change; 

• Do not make changes that you do not understand; 

• If you are unsure about making a particular change, ask a knowledgeable 
tuner first. 

Systems Requirements 

• PC or laptop running Win7 or higher. 

• USB port. 

• Color screen with 1280x960 or greater resolution. 

• 1GB of available disk space. 
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Introduction 

EFILive 

Scan Tool 

The EFILive Scan Tool records real-time data from engine and transmission 
controllers and can display that information in multiple formats. The logged data 
can be displayed using gauges similar to the instrument cluster in your vehicle or 
using strip charts that show data trends over time. 

 
Scan Tool Gauge Display 

 
Scan Tool Strip Chart Display 
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Tuning Tool 

The EFILive Tuning Tool reads and flashes calibration data and/or operating 
system code to and from vehicle controllers. The controllers may remain fitted to 
the vehicle while the read and/or flash processes are performed or the controllers 
may be removed and used with a bench harness. 

 

Sometimes reading or flashing a controller will fail due to badly behaved 
modules on the vehicle’s network. Badly behaved modules usually fall 
into the following categories: 

• Aftermarket radios. 

• Navigation systems. 

• Entertainment systems such as DVD players. 

• Diagnostic and logging systems. 

We recommend disconnecting such devices from the vehicle network or 
removing power from those devices prior to reading or flashing the 
engine or transmission controller. 

The tuning tool also provides user friendly editing options for changing the 
calibrations in the controller. 

 
Tune Tool Controller Calibration Display 

FlashScan 

FlashScan is really four devices in one: 

1. A standalone tool that can display trouble codes, system 
readiness tests and data logger. 

2. A pass-thru device allowing data logging to be displayed in 
real-time on your laptop computer. 

3. A standalone read/flash tool that can read or flash a 
controller with no laptop or PC required. 

4. A pass-thru device that can read or flash a controller from your PC or 
laptop. 

AutoCal 

AutoCal provides a convenient platform for professional tuners to 
distribute custom tunes to their customers. And for their customers to 
collect and submit logged data back to the tuner for analysis. It allows 
the tuner to update and optimize the original tune without shipping 
and/or removing controllers from customers’ vehicles. 
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Differences between FlashScan and AutoCal 

There are significant differences between FlashScan and AutoCal for end users. It 
is important that both the tuner and the tuner’s customer (end user) understand 
these differences. 

• With FlashScan, end users have the ability to create, view, and modify tunes. 
With AutoCal, only the tuner has that ability. 

• Tunes from multiple sources can be flashed with FlashScan V2, however 
AutoCal is limited to flashing tunes provided by a single tuner. 

A FlashScan Device is Required 

FlashScan is required to create tunes for an AutoCal device.  AutoCal devices 
cannot create tunes. 

Comparison 

Feature 
FlashScan 

V3 
AutoCal 

V3 
FlashScan 

V2 
(retired) 

AutoCal 
V2 

(retired) 

Display/Clear Trouble Codes     

Retrieve System Readiness 
Test Results     

Pass-thru Logging     

Pass-thru Reading/Flashing     

Standalone Logging     

Standalone Reading/Flashing     

External Analog Inputs 
    

Serial Interface 
   

1 

Master FlashScan Device 
Required     

On Board Storage 512MB 512MB 6MB 6MB 

Optional SD Card Storage 
    

Audible Alarms     

Visible Alarms     

VIN License Capacity 600 600
2
 221 221

2
 

1. Internal serial interface is available via direct connection to circuit board but 
opening AutoCal’s enclosure will void the warranty. 

2. Tuners control the number of license slots that are available for use. 
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F2: Scan 

Buttons 

Tune 

Next Tune Window (Alt+3) will make the Next Tune Window the focus window. 

New Tune Window (Ctrl+Alt+3) will open a New Tune Window. 

Tune Window will list the open Tune Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Scan 

Next Scan Window (Alt+2) will make the Next Scan Window the focus window. 

New Scan Window (Ctrl+Alt+2) will open a New Scan Window. 

Scan Window will list the open Scan Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Open 

Open (Ctrl+O) will open a data log file. 

 

When you open a version 7 (*.efi) data log file, you will be asked to 
confirm the controller type and transmission type. If you re-save the file 
using the version 8 software then you won’t be asked for the controller 
type or transmission type when re-opening the version 8 file (*.pld) 

Save 

Save (Ctrl+S) will save the scan file with its current name. 

Save As (Alt+S) will save the scan file with a new name. 

Export (Ctrl+E) will export the scan file as a *.csv file suitable for use with 
Microsoft Excel.  If a section is currently active then only the selected data will be 
exported. 



EFILive V8 Reference 

support@efilive.com - 17 - www.efilive.com 

Capture Screen to Clipboard (Shift+Alt+C) will copy the chart, gauge or map 
displayed directly to the clipboard.   

Config 

Config (Alt+Enter) opens the EFILive Property Settings window at the Scan Tool 
category. 

Calculated PIDs (Ctrl+K) opens the Calculated PIDs editor window. 

Display/Change Log File Information (Ctrl+I) allows you to view and modify log 
file specific information. 

Manage Customers and Vehicles (Ctrl+D) opens the Customer/Vehicles Details 
window. These details are embedded into the log file meta data when it is first 
saved.  Tuners can enter Customer details, Vehicle details and Comments. 

The following fields link to folder/file template tags and can be used to construct 
folder/file templates using the VIN details from the scan or tune file: 

<cn> "Customer Name" 
<reg> the "Vehicle Registration" 
<name> the "Vehicle Name" 
Note: Folder/File templates are set up in the Edit->Properties->Files/Folders-
>[Tune Templates] or [Scan Templates]. 

To alter the information once it has been embedded in a log file, open the Manage 
Customers and Vehicles window, locate and edit the record. 

Chart Properties (Shift+F4) displays the chart editing panel that can be used to 
customize the dashboard charts. 

Dashboard Properties (Shift+F5) displays the dashboard editing panel that can 
be used to customize the dashboard gauges. 

Map Properties (Shift+F6) displays the map editing panel that can be used to 
customize the dashboard maps (not available yet). 

Open Dash 

Open Dashboard (Shift+Ctrl+O) will open a dashboard file. The most recently 
used dashboard can also be selected from the drop down list at the bottom of the 
Scan Window. 

Save Dash 

Save Dashboard (Shift+Ctrl+S) will save the dashboard file with its current 
name. 

Save Dashboard As (Shift+Alt+S) will save the dashboard file with a new name. 

 

You may not save a dashboard with a file name that begins with “EFI_”, 
those file names are reserved for EFILive defined dashboard files. 

Dashboard 

Dashboard displays the last 10 used dashboards as a shortcut. 

Search/Filter PID 

Search/Filter PID displays Calculated PIDs defined with units of Boolean for 
searching or filtering logged data. 
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Close 

Close (Ctrl+F4) closes the Window. If any changes have been made and not yet 
saved you will be asked to save the changes. 

 

After you have modified which PIDs appear on the charts or gauges, 
the PID changes will be automatically saved in the current dashboard 
file.  

You may customize that behavior using the: Properties->Scan Tool-
>Dashboard->PID Selection Options. 

Parameter Identifiers (PIDs) 

Types of PIDs 

PIDs are the heart and soul of data logging. PID stands for Parameter IDentifier 
and as the name suggests a PID uniquely identifies a discreet data element that 
can be logged from the engine or transmission controller. 

All PIDs are pre-defined by EFILive in metric units.  All PID calculations are 
performed using metric units by the software. 

EFILive can log many different types of PIDs: 

Generic PIDs 

Generic PIDs are available on all controllers that are fitted to vehicles registered in 
the US and subject to OBDII regulation. Effectively that means generic PIDs are 
available on all vehicles supported by the EFILive Scan Tool. 

Enhanced PIDs 

Enhanced PIDs are defined by the manufacturer to provide data above and 
beyond what is required to satisfy the US OBDII regulations. 

Direct Memory Access (DMA) PIDs 

DMA PIDS are defined explicitly by EFILive to provide specific information directly 
from the controller’s memory. EFILive’s DMA PIDs have been carefully designed 
to provide accurate and useful tuning information directly from the heart of the 
controller. Many DMA PIDs provide values used by the controller when indexing 
(looking up) data from calibration tables. 

Calculated PIDs 

Calculated PIDs may be defined by the user as mathematical expressions that use 
the values of other PIDs (including other calculated PIDs) to provide additional 
information. For example you could create a PID to compute the injector duty cycle 
from the RPM and injector pulse width as follows: duty cycle = pulse*rpm/1200. 

External PIDs 

External PIDs are provided to collect external information such as FlashScan’s 
analog voltages, dynamometer integration and third party data logger integration. 

Third party vendors wishing to integrate their external data logging with FlashScan 
are encouraged to contact EFILive to discuss integration options. 
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F2: PIDs 

Selected Controller(s) 

Allows the selection of the Engine and/or Transmission controller. 

The Auto Detect option will connect to the controller and populate this selection. 

Available PIDs 

The list of available PIDs will be unique for individual controllers. Each time you 
select a different controller the PIDs shown in the Available PIDs section may 
change. 

 

The list of available PIDs is divided into a number of groups displayed 
with blue headings. You can configure the display to automatically 
expand all the groups via: Properties->Scan->Dashboard->Expand PID 
Selection Groups Automatically. 

To help locate a specific PID, you can enter all or any part of the PID’s name, 
description or units into the “Search:” text box at the bottom of the window. When 
you stop typing into that text box EFILive will search for and display only those 
PIDs that match the search text. For example, if you were looking for a PID that 
had something to do with spark, then you should enter the text spark.  

Click the  button to clear the search options and display all PIDs again. 

Selected PIDs 

To include PIDs in the data log, you must “select” them. To select PIDs, highlight 
them and drag them from the from the Available PIDs section to the Selected PIDs 
section, or click the  button or press the hotkey Ctrl+Ins. 

To unselect PIDs, highlight them and click the  button or press the hotkey 
Ctrl+Del. 

If a custom dashboard is open, the  button will copy all PIDs saved in the 
dashboard into the Selected PIDs window. 

You can highlight multiple PIDs at once by left-clicking on them in combination 
with the Ctrl or Shift keys. Holding the Ctrl key down while left-clicking will allow 
you to select multiple individual PIDs. Holding the Shift key down while left-clicking 
will allow you to select a range of PIDs. Only PIDs that are in the same group can 
be selected at once.  

Validating PIDs 

PID validation only validates: generic, enhanced and custom PIDs.  It does not 
validate: calculated, external or 3rd party PIDs. 

To determine valid PIDs for a particular controller and operating system, connect 
FlashScan/AutoCal to your PC and vehicle, select the appropriate controller(s) in 
the scan tool and select the  button.  If not connected, select the target operating 
system to retrieve previously validated PIDs for that operating system. 

All PIDs that are available for the selected controller(s) will be assessed 
irrespective of selected PIDs.  PIDs that are invalid for a particular OS will be 
displayed with a  icon to indicate that they should not be selected for the target 
operating system. 
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Channel Allocation per Module  

Shows the channel usage by controller.  Channel selected should not exceed the 
maximum capacity per controller. 

Virtual Dashboards 

A virtual dashboard provides a complete scan configuration profile.  The virtual 
dashboard saves PID configurations, chart configuration, gauge layouts and 
custom maps for a particular controller.  EFILive provides a range of sample 
dashboards for users, however users can create their own. 

Common Functions 

Each dashboard page contains a range of features that are consistent across 
virtual dashboard pages.  In addition to frame counts and log time stamp 
information, a range of common buttons exist. 

Task Mouse Hot Key 

Clear Logged Data 
 

Ctrl+N 

Record  Ctrl+R, or 

<Numeric KeyPad 0> 

Monitor  Ctrl+M 

Pause/Resume  Ctrl+Space 

Start Play Back  Ctrl+P 

Stop  Ctrl+Q, or  

<Numeric KeyPad 0> 

Repeat  Ctrl+L 

Real-Time Speed  Ctrl+T 

Data Logging Profiler Display   Ctrl+Y 

F3: Data 

The Scan Tool’s Data tab page shows each selected PIDs’ data and statistical 
information. 

The precision displayed for each value is dependent on the value as follows: 

• If the value is 0 then only 0 is displayed (with no precision) 

• If the value is between -0.001 and 0.001 then the precision is 6 decimal 
places. 

• If the value is between -1 and 1 then the precision is 3 decimal places. 

• If the value is between -10 and 10 then the precision is 2 decimal places. 

• If the value is between -100 and 100 then the precision is 1 decimal places. 

• If the value is less than -100 or greater than 100 then the precision is 0 
decimal places. 

• If trailing zeros exist after the decimal point, then they are stripped. 
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F4: Charts 

Strip charts show the recorded logged data. This view of the data is usually the 
most useful for analyzing trends over time and for comparing various PIDs’ values 
at the same point in time. 

To display the charts as a full screen, press F10. To exit from full screen mode 
press Escape. 

Task Mouse Hot Key 

Make a Selection Click and drag left or right Shift+Left 
Shift+Ctrl+Left 
Shift+ Right 
Shift+Ctrl+Right 

Clear a Selection Click outside selection Left 
Ctrl+Left 
Right 
Ctrl+Right 

Crop Selected  

Right-click on chart, select: 
Crop. 

Ctrl+BackSpace 

Delete Selected  

Right-click on chart, select: 
Delete 

Ctrl+Delete 

Zoom to Selection Click inside selection 

Right-click on chart, select: 
Zoom->Zoom Selected. 

Ctrl+Alt+S 

Zoom None Click time scale 

Right click on chart, select: 
Zoom->Zoom None. 

Ctrl+Alt+N 

Zoom Actual Right click on chart, select: 
Zoom->Zoom Actual. 

Ctrl+Alt+Z 

Zoom In Ctrl+Scroll Wheel Forward 
Mouse must be over the data 
area. 

Right click on chart, select: 
Zoom->Zoom In. 

Other: 
Use chart magnification slider 
below the scroll bar. 

Ctrl+Alt+I 
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Zoom Out Ctrl+Scroll Wheel Back 
Mouse must be over the data 
area. 

Right click on chart, select: 
Zoom->Zoom Out. 

Other: 
Use chart magnification slider 
below the scroll bar. 

Ctrl+Alt+O 

Pan Left Scroll Wheel Forward 
Mouse must be over the data 
area. 

Other: 
Use scroll bar under time scale. 

Left 
Ctrl+Left 

Pan Right Scroll Wheel Back 
Mouse must be over the data 
area. 

Other: 
Use scroll bar under time scale. 

Right 
Ctrl+Right 

Show/Hide Chart 
Notes 

 Ctrl+U 

Filter data based on 
selected Filter PIDs 
value 

 Ctrl+F 

Search backwards for 
previous change in 
Filter PIDs value 

 Ctrl+PgUp 

Search forwards for 
previous change in 
Filter PIDs value 

 Ctrl+PgDn 

Auto Scale PID 
Zero Biased 

 

Right click on PID, select: 
Auto Scale this PID. 

Attempts to locate the scale’s 
zero point at the top, center or 
bottom of scale. 

 

Auto Scale PID 
Min/Max Biased 

Shift+Click  

Attempts to make the scale 
10% larger than the displayed 
data. 
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Auto Scale PID 
Permanent 

Ctrl+ Click  

Attempts to locate the scale’s 
zero point at the top, center or 
bottom of scale. 

This option alters the PID’s 
default min/max values. 

 

Auto Scale PID 
Default 

Click in the scale area. 

Sets the displayed min/max 
values to the PID’s default 
min/max values. 

 

Auto Scale All PIDs Right click on chart, select: 
Auto Scale All PIDs. 

Ctrl+Alt+A 

Default Scale All PIDs Right click on chart, select: 
Default Scale All PIDs. 

Ctrl+Alt+D 

 

Pan PID Up Scroll Wheel Forward 
Mouse must be over the 
appropriate scale. 

 

Pan PID Down Scroll Wheel Back 
Mouse must be over the 
appropriate scale.  

 

Zoom PID In Ctrl+Scroll Wheel Forward 
Mouse must be over the 
appropriate scale.  

 

Zoom PID Out Ctrl+Scroll Wheel Back 
Mouse must be over the 
appropriate scale.  

 

Copy Scale Ctrl+Click and drag from one 
scale to another. 

 

Hide PID   

Show PID   

Show Start/End 
Frames 

Right click on chart, select: 
Show Start/End Frames. 

Ctrl+Alt+L 

Fetch Start/End 
Frames 

Right click on chart: 
Fetch Start/End Frames. 

Ctrl+Alt+F 

Move Start/End 
Frames 

Click and drag  tabs.  
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Toggle Mouse Control Right click on chart, select: 
Ignore Mouse. 

Click in chart area to resume 
mouse control. 

Ctrl+F2 

F5: Gauges 

The Gauges tab page shows a virtual instrument cluster that displays the logged 
data in real time. 

To display the gauges as a full screen, press F11. To exit from full screen mode 
press Escape. 

F6: Maps 

Maps are used to display a single PID as a surface function of two other axis PIDs.  
Maps display the aggregate (count, minimum, average and maximum) values of 
one PID in a matrix based on the values of two other PIDs.  These maps are also 
known as pivot tables or histograms. 

For example you could choose to plot the spark advance surface function on a grid 
indexed by RPM and throttle position. Map data can be compared with calibration 
tables to evaluate tuning changes. Maps can also be configured to record 
percentage differences (via carefully crafted calculated PIDs) between 
commanded and actual calibration data which can then be used to update the 
calibrations. 

There are ten maps.  To change the display between each map, click on the tabs 
A through to J. 

Task Mouse Hot Key 

Map Properties  Right click on map: 

Map Properties. 

Shift+F6 

Chart Linking Right click on map: 
Chart Linking. 

Ctrl+Alt+K 

Transpose  Right click on map: 
Transpose. 

Ctrl+Alt+T 

Copy Selected Cells Right click on map: 
Copy 

Ctrl+C 

Copy with Labels Right click on map: 
Copy with Labels 

Shift+Ctrl+C 

Copy/Paste Default 
Settings 

Right click on map: 
Copy/Paste Default Settings 

 

Select Data PID Right click on map: 

Select Data PID 

 

Select Column PID Right click on map:  
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Select Column PID 

Select Row PID Right click on map: 

Select Row PID 

 

Display Minimum 
Value 

  

Display Maximum 
Value 

  

Display Average Value   

Display Cell Count   

F7: DVT 

 

DVT is for use by experienced EFI technicians. 
It temporarily overrides the normal operation of the controller and, if 
used incorrectly can damage the powertrain and/or the vehicle. 

Open the [F2: Scan] tab page and select the target controller(s) on the [F2: PIDs] 
tab page. You can select both an engine and transmission controller. However, 
only one device may have DVT controls active. 

Select the [F7: DVT] tab page and click on the controller for which you want to 
activate DVT controls. 
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The controller will be queried to determine which DVT controls are available and 
those available DVTs will be displayed. Some DVTs will be disabled, those DVTs 
are not supported on the current controller.  

 

 

Not all overrides are available on all vehicles. Different model years 
support different combinations of override commands. 

 

Before any controls can be used the DVT system must be activated. Click the 
[Activate] button to activate the DVT controls. 

 

To de-activate the DVT system, click the [De-Activate] button. 

 

 

Do not attempt to use any DVT controls while the vehicle is in motion. 
Always use a dynamometer if you need to use DVT controls while the 
vehicle is being driven. 

It is possible to activate many DVT controls at the same time. EFILive 
recommends using only one or two controls at the same time. 
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Do not attempt to use any DVT controls to command settings that 
exceed the capabilities of the vehicle. It is possible to damage vehicle 
components and cause injury to yourself and/or others if misused. 

Most controls have a checkbox at the top left. That checkbox activates/de-
activates individual control. You should set the value or option within the control to 
the desired value before activating the control. For example, if you are using the 
“Desired Idle Speed Control”, you should set the rpm to the desired speed prior to 
checking the control’s activation checkbox – otherwise if the desired rpm was set 
to 0 then when you activate the control it will attempt to idle at 0 rpm – which will 
probably stall the engine. 

Some controls are grouped by function and displayed using a common color. 
When a grouped control is active it is displayed in a bolder/darker color, when a 
grouped control is de-activated, it is displayed in a lighter color. You can see the 
top left control, once activated has a darker background color. 

 

 

Single controls that are not part of a group, are displayed with a gray background 
when de-activated and with a green background when activated. 

 

 

Controls that do not have a checkbox are always active and ready to be used. 

 

Each time you change the state or value of an active control a message will be 
displayed showing the result of the change. If the change was successful then the 
controller will respond with “OK”, like this: 
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If the controller rejects the DVT control it will respond with an error message like 
this: 

 

Some DVT controls require that the controller is not secured with a seed/key. For 
those controls you need to click the [Secure Access] button. That will send the 
stock key to the controller to un-secure it. If the controller is secured with a non-
stock key and you know the key, you can supply the key in the “Key:” text box. If 
you don’t know the key then you cannot use any controls that require the controller 
to be un-secured. 

Some controls like the “Injector Flow Test” and “Crank Angle Sensor Error 
Learning” can only be performed once per ignition cycle. 

Many controls will only work if/when certain conditions are met. For example, the 
“Crank Angle Sensor Error Learning” requires conditions such as the engine to be 
at operating temperature, the hood to be closed and the park brake applied. 

Editing Gauges 

See the separate document “EFILive V8 Gauge Editor”. 

Comparing Data Logs 

(Not available yet) 

Log File Information 

To display and/or change the non-PID information in the log file, such as 
comments and various vehicle options, select the “Display/Change Log File 
Information” option from the [Config] button’s drop down menu or press the Ctrl+I 
hotkey. 

Calculated PIDs 

There are two types of Calculated PIDs: 

 EFILive Calculated PIDs – Are predefined by EFILive and cannot be modified 
by the end user. 

 User Calculated PIDs – Are created by the user and can be modified by the 
user. 

Calculated PIDs should be defined using metric units because all PIDs predefined 
by EFILive and all PID calculations are performed using metric units.  Defining 
Calculated PIDs using units other than metric will prevent unit conversion routines 
from working correctly. PIDs defined using the correct metric units may be 
displayed using any of EFILive’s pre-defined US customary units or if required, 
using custom units defined by the user. 

Calculated PIDs Expression Editor 

The EFILive Scan Tool contains an expression editor where users can create, 
view and modify their calculated PID expressions. 
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The Calculated PIDs expression editor can be accessed via the drop down menu 
on the [Config] button.  Select “Calculated PIDs” or press the Ctrl+K hotkey. 

Task Mouse Hot Key 

Add PID Group  Shift+Ctrl+Ins 

Delete PID Group  Shift+Ctrl+Del 

Display Search Options  Ctrl+F 

Add PID  Ctrl+Ins 

Delete PID  Ctrl+Del 

PID Group – add a PID Group by using the  button.  Enter a group name 
and description. Group names are limited to 4 uppercase letters and numbers. 

User Defined PID – highlight one of the user defined PID groups in the Group 
list, then click the  button in the PID list to add a user defined PID.  Enter the 
PID (Parameter identifier code), Name, Units and Precision. Parameter 
identifier codes are limited to 11 uppercase letters and numbers. 

Click the [Edit] button (or double click the calculated PID) to display the 
expression editor window where you can edit the calculated PID’s expression.  
Calculated PIDs use the Lua 5.x scripting language, documentation is 
available here: Lua 5.3.  Pre-defined EFILive functions, Lua code blocks and 
selected PIDs can be added by clicking on the required item in the list to the 
right. 

Use the [Test] button to validate the programming expression.  

EFILive PID Compiler 

Some supported controllers are capable of data logging more PIDs than EFILive 
has pre-defined for the controller. Users can define many of those additional PIDs 
so that they can be data logged along with the pre-defined EFILive PIDs.  

DMA (Direct Memory Access) PIDs are also supported, allowing users to data log 
specific data from specific RAM addresses in a target controller.  

For instructions on defining PIDs and DMA PIDs, please review the comments and 
example PID definitions in the *.ini files in the folder \Documents\EFILive\V8\User 
Defined PIDs. 

https://www.lua.org/manual/5.3/contents.html#index
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F3: Tune 

Buttons 

Tune 

Next Tune Window (Alt+3) will make the Next Tune Window the focus window. 

New Tune Window (Ctrl+Alt+3) will open a New Tune Window. 

Tune Window will list the open Tune Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Scan 

Next Scan Window (Alt+2) will make the Next Scan Window the focus window. 

New Scan Window (Ctrl+Alt+2) will open a New Scan Window. 

Scan Window will list the open Scan Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Open 

Open (Ctrl+O) will open a tune file. 

Save 

Save (Ctrl+S) will save the tune file with its current name. 

Save As (Alt+S) will save the tune file with a new name. 

Save As (Read Only)… will save the tune file with a new name and set that new 
file to read-only. Use this option to designate the new file as a permanent archive 
that does not allow any further changes to be saved into it. To remove the read 
only flag, right click on the file using Windows Explorer and select Properties, then 
uncheck the Read-only check box. 

Save (Calibration Only)… will save only the calibration portion of the tune file. 
Calibration only files are significantly smaller than a full tune file. 
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Use this option to save multiple calibrations for storage on AutoCal 
devices that have limited capacity. Calibration only files cannot be re-
opened nor edited using the EFILive software. 

Save, For AutoCal (Shift+Ctrl+S) same as “Save” but tags the saved file with the 
attached FlashScan’s License number which authorizes the saved file for use with 
any AutoCal linked to the FlashScan device. 

Save As, For AutoCal (Shift+Alt+S) same as “Save As” but tags the saved file 
with the attached FlashScan’s License number which authorizes the saved file for 
use with any AutoCal linked to the FlashScan device. 

Save (Calibration Only), For AutoCal - same as “Save (Calibration Only)…” but 
tags the saved file with the attached FlashScan’s License number which 
authorizes the saved file for use with any AutoCal linked to the FlashScan device. 

Capture Screen to Clipboard (Shift+Alt+C) will capture screen contents to the 
clipboard. 

Capture Graphic to Clipboard will capture only the graphic display to the 
clipboard. 

Capture Table to Clipboard will capture only the table display to the clipboard. 

Config 

Config (Alt+Enter) Opens the EFILive Property Settings window at the Tuning 
Tool category. 

Close 

Close (Ctrl+F4) closes the Window. If any changes have been made and not yet 
saved you will be asked to save the changes. 
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Reading Calibrations 

Click on the [Auto Detect] button to detect which controllers are available for 
reading via the attached FlashScan or AutoCal device. 

If the controllers cannot be automatically detected, you can manually select the 
controller(s) by right clicking in the grey square and selecting the correct controller. 

The green tick that appears on the controller’s image indicates which controller 
(engine or transmission) will be read. Click on either controller to select it for 
reading. 

Try Stock Key attempts to gain access to the controller using the stock key.  

Try This Key allows you to specify the actual key that will be used to gain access 
to the controller. Use this option if you know the controller is locked and if you 
know the key that was used to lock it. Keys may be entered in decimal (1..65535) 
or in hexadecimal ($0001..$FFFF). 

Try Common Alternative Keys attempts to gain access to the controller using 
additional keys. Use this option if EFILive reports that the controller is locked but 
you suspect it has not been locked with a custom key. 

Assume Lock May Be Faulty ignores any security reported by the controller 
during reading or flashing and assumes the controller’s security is non-functional 
and proceeds with the read operation regardless. Use this option if EFILive 
reports: 

• the controller is locked (but you suspect it has not been locked with a 
custom key) or 

• the controller has “returned to normal operations”. 

Try Additional Unlock Strategies attempts to gain access to the controller by 
using a different seed/key strategy. If and when a controller cannot be unlocked 
using the above options, EFILive support may request that you use this option in 
conjunction with additional data supplied by EFILive support. Using this option 
without the additional data from EFILive support is not useful. 

High Speed (VPW Only) will use the high speed VPW mode to transfer data from 
the controller. High speed VPW runs at 41.6kbps which is 4 times faster than 
standard VPW which runs at 10.4kbps. 

 

For CAN controllers, EFILive has developed a proprietary “Fast CAN 
Mode” that can be selected in the FlashScan/AutoCal device settings. 
EFILive’s Fast CAN Mode provides a modest speed increase when 
reading and/or flashing controllers. 

Exclude Boot Block When Reading Cummins HD Controllers will exclude the 
boot block resulting in reading the controller faster, but may result in a file that 
does not contain all the detailed information from the vehicle. 

Show Summary When Finished will automatically display the [F3: Calibration] 
tab page when reading is complete. 

Read will start the read process. 

Quit will stop the read process. Stopping a read process midway through will not 
harm the controller. Usually an ignition off-countdown-on cycle will reset the 
controller successfully. In the worst case scenario, you may need to reset the 
controller by removing and restoring battery power. 
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Lock/Unlock the controller with your known key.  Used for controllers that support 
Auto-Lock via a boot loader (E38, E40, E54, E60, E67, LS1B). 

Problems Reading a Controller 

There are a number of reasons why a controller may not be read, these include: 

Check Software and Firmware Version: Ensure you are running the most up to 
date software and firmware. 

Check Aftermarket devices: The read and flash operations command other 
modules on the vehicle communications bus to be silent. Some aftermarket 
devices do not respect the bus silence command and continue to transmit during a 
read or flash operation. That will usually cause the read or flash to fail. Aftermarket 
devices should be disabled (pull the fuse) or disconnected from the vehicle’s 
communications bus prior to reading or flashing. 

Do no operate vehicle: DO NOT operate any vehicle feature that may 
communicate on the data bus. This includes opening or closing of hood, doors, 
windows, as well as changing settings on radio, HVAC, connecting/removing 
charging devices etc. 

Read Block: A previous tuner may have prevented access to the controller by 
applying the [Block ECM Calibration Reading] parameter in the tune tool. 

Read Restriction: Some manufactures have commenced implementing restrictive 
architecture preventing the contents of the controller from being read. 

Custom Operating Systems: For some Custom Operating Systems EFILive 
writes tune files to non-readable memory. These tune files cannot be read out from 
the ECM. 

NVRAM Status: Where the NVRAM area of the ECM is corrupted the vehicle may 
still run, however the tune file cannot be read or flashed. Typically where the VIN, 
Serial number, Hardware number and/or calibration ID do not contain valid data, 
the controller will need to be repaired to restore read and flash functionality. 
Please refer to the NVRAM Status article for further information. 

Controller Selection: Use the [Auto Detect] option to check the correct controller 
is selected. 

Test for Rogue Modules: FlashScan/AutoCal V3 users can access a range of 
test modes to check the network for rogue modules that may cause read or flash 
operations to abort are available by navigating to the Tune Tool -> F1: Tuning -> 
F4: Test OBD Network menu. 

If reading continues to fail, please see this knowledgebase article: 
https://service.efilive.com/kb/articles/problem-reading-a-controller  

https://service.efilive.com/kb/articles/nvram-status
https://service.efilive.com/kb/articles/problem-reading-a-controller


EFILive V8 Reference 

support@efilive.com - 34 - www.efilive.com 

Segments and Checksums 

Controllers store their operating system code and calibration data in flash memory 
which is a type of computer memory that retains its contents even when power is 
removed. Usually flash memory is extremely robust and the data programmed into 
it remains unchanged for many, many years. However, faults can and do occur, so 
the controller must be able to reliably detect if and when the contents of the flash 
memory change unexpectedly.  

Controllers employ various strategies to detect if and when the flash memory 
changes, one such strategy is to constantly sum up all the numbers in the 
controller’s flash memory and to compare the total sum to a known sum that has 
previously been stored in the controller’s flash memory. That sum is called a 
checksum. If the computed sum does not match the stored sum then the controller 
assumes that the flash memory has been corrupted and that the data is no longer 
reliable. 

Once a change has been detected the controller will usually go into limp mode or it 
may even prevent the engine from starting. 

When EFILive is used to edit a calibration file the controller must be told that the 
changes are ok and should not be detected as faults. To do that, EFILive 
computes the correct checksum and stores that checksum back into the flash 
memory. That way, when the controller performs its own sum it will match the sum 
stored by EFILive. 

Each segment’s checksum status can be one of five states; each state is 
displayed by EFILive using a different icon: 

Icon Description 

 Checksum is correct. 

 Checksum is incorrect and disabled. 

This means the segment checksum has been set incorrectly but 
the controller has been instructed to not compute or verify the 
checksum during normal operating conditions. 

If a flash memory fault does occur the controller will not be able 
to detect it and the controller will continue to operate with faulty 
data. 

Usually this is caused when the data has been modified by a third 
party who has not updated or is not technically competent to 
update the checksum correctly. 

 Checksum is correct but disabled.  

This means the segment checksum has been set correctly but 
the controller has been instructed to not compute or verify the 
checksum during normal operating conditions. 

If a flash memory fault does occur the controller will not be able to 
detect it and the controller will continue to operate with faulty data. 

 Checksum is incorrect 

This indicates that the data in the tune file does not match the 
controller’s checksum.  

EFILive will not allow a tune file with incorrect checksums to be 
flashed into a controller. 
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 EFILive is not configured to read or flash this segment – 
checksum is not managed by EFILive. 

This indicates that the EFILive software does not have enough 
information about the segment to compute the checksum and 
that the segment will never be flashed into a controller so it is not 
necessary for the EFILive software to manage the checksum. 

 EFILive is not yet configured to manage checksums for this 
segment. 

This indicates that the EFILive software is not yet able to 
calculate, verify or update the checksum for the indicated 
segment. The checksum may still be correct, but the EFILive 
software cannot verify that the checksum is correct. 

Please send the file to EFILive so that we can add the 
configuration data required to calculate the checksums for this 
operating system. 

EFILive will still allow you to flash the file but you must first be 
absolutely sure that the checksums are correct or the vehicle will 
be left in a no start condition after the flash is complete. 

If you read a controller or open a tune file that shows one or more incorrect 
checksums we highly recommend not using that tune file to re-flash back into the 
same controller or into any other controller. 

Sometimes the checksums are left disabled when a vehicle leaves the 
manufacturer (we don’t know why), but EFILive can correct and re-enable the 
checksums. To do that right click on the segment you wish to correct and select 
“Force Checksum to be Correct”. 

All segments will be updated simultaneously. 

Depending on the size of the segments it may take a few seconds to recomputed 
and update the checksums. 

 

NEVER, EVER force a checksum to be correct unless you are 100% 
certain that the file was obtained from a working controller and that 
the file has not be tampered with or modified outside of the 
EFILive software. Doing so will almost certainly render the controller 
inoperable and possibly unrecoverable. 

Segment Import/Export 

For GM controllers: Segments can be imported and exported from the [F3: 
Calibration] window by selecting one or more segments, right-clicking and 
selecting "Import" or "Export". You may export multiple segments at the same time 
but you may only import segments one at a time. 
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Main Operating System, Secondary Operating System and Boot Software 
segments cannot be imported or exported.  

Not all controller types (for example E20, E47, E55, E69, E77, LS1A and some 
older VPW controllers) currently support segment import and export. 

If a tune file has security settings of "Can Only be Viewed" then segments cannot 
be imported until that security setting is removed. 

If a tune file has security settings of "Cannot be Viewed or Modified" then 
segments cannot be imported or exported until that security setting is removed. 

When exporting multiple segments, you will be prompted to enter a unique suffix 
that will be appended to each segment's exported filename to prevent overwriting 
previously exported segments with the same part numbers. 

You may only import a segment if that segment's operating system number 
matches the target tune file's operating system number. The segment number may 
be different. 

Editing Calibration Data 

Editing calibration data is performed on the [F5: Edit] tab page.  An editable tune 
file must be open before any calibration data can be displayed and/or edited. 

Segments are displayed in the navigation tree in the same order used by the 
manufacturer. 

 

For some controllers the segment display order presented in the V8 
software will be different to the segment display order presented in 
the V7 software. 

There is no software registration required to activate the full features of the V8 
tune editor. The V8 software may be used to edit, upgrade to custom operating 
systems and save tune files without any registration. 

Some calibrations are displayed with red icons. The red icon indicates that the 
calibration should only be modified by tuners who fully understand the 
consequences of the modifications. 

A FlashScan device is required to be connected to the PC when saving files where 
the author wants to apply tune file security, or for use with remote AutoCal devices 
that have been linked to that FlashScan device. 

File Management 

Task Icon Hot Key 

Close alternate calibration.   

Open second file for comparison.  Shift+Ctrl+O 

Display comparison results.  Ctrl+1 

Show calibration data.  Ctrl+4 

Show alternate calibration data.  Ctrl+5 

Show difference between calibration and 
alternate. 

 Ctrl+6 

Show relative percentage difference between 
calibrations calculated as  

 Ctrl+7 
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((current-alternate)*100)/alternate.  

Show absolute percentage difference between 
calibrations calculated as 

((current-alternate)*100)/(max-min). 

 Ctrl+8 

Display calibrations that contain out of range 
values. 

  

Display list of calibrations modified since last 
saved. 

Custom Operating systems do not show as a 
modification because they cannot be 
undone/redone. 

 Ctrl+M 

Convert data between units.  Ctrl+Alt+Enter 

Speedo calculator   

Cummins injection timing calculator   

Hide/Show navigator tree.  Ctrl+F1 

Hide/Show view toolbar   

Hide/Show adjust toolbar   

Open the EFILive V8 Reference Manual.  F1 

Navigator Tree 

Task Icon Hot Key 

Add the currently highlighted calibration in the 
navigator tree to the favorites list. 

  

Expand currently selected node.  Shift+F9 

Collapse currently selected node.  Shift+Ctrl+F9 

Search all calibrations for text in search box.  Enter 

Search backwards from previous calibration.  Shift+Ctrl+F3 

Search forwards from next calibration.  Ctrl+F3 

Update the corner flashes on the navigator tree 
icons that indicate modified calibrations. This 
option is useful when multiple calibrations are 
defined (usually via *.cax8 files) that overlap the 
same memory area in the tune file. After 
modifying one calibration the overlapping 
calibration may also contain modified data but it 
won’t be indicated in the navigator as being 
modified until you click this refresh button. 

  

Display a brief explanation of navigator search 
options. 
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Display Options 

Task Icon Hot Key 

Revert all changes to when file was opened.  Ctrl+R 

Undo last change.  Ctrl+Z 

Redo last undo.  Shift+Ctrl+Z 

Set default view   

Show 2D chart.  Ctrl+2 

Show 3D surface plot.  Ctrl+3 

Rotate 3D surface plot.  Ctrl+0 

Transpose (i.e. swap) row and column axis.  Ctrl+Alt+T 

Set custom view.   

Set default view (hold Ctrl for larger graphic, hold 
Shift to set as user default). 

  

Show graph only.   

Show table only.   

Increase displayed precision.  Ctrl+Alt+I 

Decrease displayed precision.  Ctrl+Alt+O 

Increase displayed precision for column labels.   

Decrease displayed precision for column labels.   

Increase displayed precision for row labels.   

Decrease displayed precision for row labels.   

Add currently displayed/selected calibration to 
the favorites list. 

  

Calibration Editor 

Task Icon Hot Key 

Set value of selected cells.   

Add to selected cells.   

Subtract from selected cells.   

Increase selected cells by percentage.   

Decrease selected cells by percentage.   

Multiply selected cells.   

Divide selected cells.   

Clip selected cells to maximum.   

Clip selected cells to minimum.   

Reduce selected cells by 1.0.  F11 



EFILive V8 Reference 

support@efilive.com - 39 - www.efilive.com 

Increase selected cells by 1.0.  F12 

Reduce selected cells by 0.1.  Ctrl+F11 

Increase selected cells by 1.0.  Ctrl+F12 

Fit curve to selected cells options.  Shift+F10 

Fit curve horizontally – a minimum of 3 cells must 
be selected. 

  

Fit curve vertically – a minimum of 3 cells must 
be selected. 

  

Fit curve horizontally and vertically – a minimum 
of 3 cells must be selected. 

  

Smooth selected cells horizontally – a span of at 
least 3 columns must be selected. 

 Shift+F11 

Smooth selected cells vertically – a span of at 
least 3 rows must be selected. 

 Shift+Ctrl+F11 

Smooth selected cells horizontally and vertically 
– a span of at least 3 columns/rows must be 
selected. 

 Shift+Alt+F11 

Make horizontal gradient – a minimum of 3 cells 
must be selected. 

 Shift+F12 

Make vertical gradient – a minimum of 3 cells 
must be selected. 

 Shift+Ctrl+F12 

Make rectangular gradient – a minimum of 3 cells 
must be selected. 

 Shift+Alt+F12 

Make horizontal gradient, interpolate non-linear 
axis. 

  

Make vertical gradient, interpolate non-linear 
axis. 

  

Make rectangular gradient, interpolate non-linear 
axis. 

  

Navigator Tree icon descriptions 

Icon Modified Description 

  Calibration segment. 

  Calibration folder. 

  Parameters. 

  2D Calibration. 

  3D Calibration. 

  Calibration folder that contains advanced 
calibrations. 

  Advanced parameters. 
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Advanced parameters should not be changed 
without a full and clear understanding of their 
purpose. 

  Advanced 2D Calibration. 

Advanced parameters should not be changed 
without a full and clear understanding of their 
purpose. 

  Advanced 3D Calibration. 

Advanced parameters should not be changed 
without a full and clear understanding of their 
purpose. 

  DTC list. 

  Custom Operating system. 

This icon does not have a modified format 
because once applied, a custom operating 
system cannot be undone. 

When the navigator tree shows a modified icon, the corresponding font color is 
also changed to highlight that it has been modified. 

The modified status of each calibration and all navigator items are reset to “not 
modified” when the file is saved. 

Navigator Search 

Searching for a calibration ID (also known as a calibration name) will only attempt 
to search for a calibration with that name. It will not search for references to that 
calibration in the description of other calibrations. 

To search for a reference to a calibration name, enclose the calibration name in 
curly braces. 

• Prefix a calibration name with the @ symbol to only search for that exact 
calibration. 

• Searching for a calibration name without using the @ prefix may find 
references to that calibration. 

• Enclose multiple words in quotes “…..” to search for that exact phrase. 

• Enclose multiple words in parenthesis (….) to search for any word. 

• Enter separate words to search for all words in any order. 

• Prefix a search value with =, <, >, <= or >= to search for a calibration value, 
such as 
=150 to search for values that are equal to 150, or 
>=PWM to search for text values that contain the text "PWM". 
Add a :units suffix to search for a particular value:unit, such as 
>=4500:rpm to search for rpm values that are greater than or equal to 
4500rpm. 
Note: Only parameter style calibrations (i.e. non-tables) are searched. 
Searches are performed using the calibration's metric value. 

If a search is successful, the calibration will be opened and the navigator will be 
expanded to reveal the calibration entry. 
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Clicking on the search box drop down arrow will display the most recent search 
history. 

 

The navigator search will search all Diagnostic Trouble Codes (DTC) 
and their descriptions even when the DTC calibration tables are closed, 
an improvement over V7 which required the DTC calibration table to be 
open before they could be searched. 

Favorites 

Calibrations can be saved in the [Favorites] tab page of the navigator. Use the 
“Add to Favorites” button in the navigator tree tool bar to add the calibration 
directly from the navigator. Use the “Add to Favorites” button in the display 
options tool bar to add the currently displayed/selected calibration or parameter 
to the favorites list. 

The first ten favorites can be opened using the hotkeys Shift+Ctrl+1 through 
Shift+Ctrl+0.  All other favorites can be opened by double-clicking on the item 
in the favorites list. 

Re-order the list of favorites by selecting an item and using the up or down arrow 
buttons at the bottom of the favorites display. 

Delete or Delete All to remove calibrations from the favorites list. 

Tab Management 

Tabs are opened by double clicking on a calibration in the navigator window, 
performing a search that returns a match, or clicking a calibration link in a 
calibration description. 

Up to ten tabs can be opened at one time.  When an eleventh tab is opened, the 
least recently used tab is closed, allowing the current selection to be opened. 

Use the arrow buttons at the top right of the edit window to scroll the tabs left and 
right to view open tabs that are not visible on the current display, or use the page 
list button to list/select any of the currently open tabs. 

Tabs can be moved and reordered by dragging the current tab to a different point 
in the tab list. 

To close a tab, make it current and click the  icon. 

For faster tab management, right click in the tab area and select from the following 
options: 

• Close Current Tab (Shift F4) 

• Close All Tabs 

• Close Tabs to the Left 

• Close Tabs to the Right 

• Close All Tabs 

Modifications 

The  icon and the Ctrl+M hot key will open the modifications tab. The 
modifications tab displays a list of calibrations modified since the tune file was last 
saved. 

Custom Operating systems do not show as a modification because they cannot be 
undone/redone. 
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Where a calibration axis is modified, the modifications tab will list that the 
calibration axis has changed, but will not list each calibration that uses that axis as 
modified.  

Click [Refresh] to re-scan the tune file for modifications. 

2D and 3D Calibration Display 

 

The calibration “map” display is split into three sections. 

1. The top left section displays either a 2D or 3D representation of the tabular 
data. 

2. The top right section displays unit information, descriptions, scan-linking 
and user notes related to the calibration. 

3. The bottom section displays the tabular data. 

The visual display can be changed using the two splitters to resize each section, 
or by using one of the tool bar icons.   

Task Icon Hot Key 

Set custom view.   

Set default view. 

• Hold Ctrl for larger graphic. 

• Hold Shift to make the new layout the 
custom view. 

  

Show graph only.   

Show table only.   

To swap between 3D view and 2D view, the following options exist. 

  or Ctrl+2 to display as 2D chart. 
  or Ctrl+3 to display as 3D surface plot. 
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When a calibration is opened, it will always display using the default 2D or 3D 
graphic. The default graphic is indicated by the icon next to the calibration item in 
the navigator tree. 

3D Surface Plot Control 

Click (and drag) with the left mouse button to select cells.  Combine with [Ctrl] 
and/or [Shift] to make multiple selections. 

Click the  icon, use the Ctrl+0 hot key or click and drag the right mouse button to 
rotate the display. 

Click and hold the mouse scroll wheel, then move the mouse to move the display. 

Move the scroll bar (or the mouse scroll wheel) up to zoom in and down to zoom 
out. 

Click both mouse buttons or the  icon to reset 3D plot size and position. 

Use the  to access help options for controlling the 3D surface display. 

2D Chart Control 

2D charts display each column of data as a separate series of data points in the 
chart. 

The active series is defined as the data column that contains the focus cell. 

The active series is shown with the data points as circles or squares. Circular if 
the corresponding cell is not selected, square if the corresponding cell is 
selected. 

If cells are selected from multiple columns in the table, then the column 
containing the focused cell will be displayed as the active series. 

Where one or more entire columns are selected, only those columns’ series will be 
displayed in the 2D chart.  All other (non-selected columns) series will be hidden 
from view. 

Click (and drag) with the left mouse button to modify data points.  When a data 
point is dragged above the highest or below the lowest point the chart’s vertical 
axis will be automatically adjusted when the mouse button is released. 

 

An entire series can be remapped using the mouse. Place the mouse 
pointer within the chart boundaries, then hold down the left mouse 
button and drag the mouse across the chart from left to right (or right 
to left). The data points of the active series will follow the mouse. 

The initial mouse movement determines the modification mode. If the initial mouse 
movement is up/down, then only the current point can be modified vertically – no 
matter how far left/right the mouse is moved. If the initial movement is left/right 
then all data points can be modified vertically by dragging the mouse 
left/right/up/down across the entire chart. 
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Parameters 

 

Some calibrations are simple values rather than tables. The EFILive Tuning Tool 
groups these single value calibrations into sets called parameters. 

Where multiple parameters all require the same change, multiple parameters can 
be selected and they will all be updated when one parameter in the group of 
selected parameters is edited. 

Numeric parameters can be edited by clicking in the cell to be changed and 
entering a numeric value.  The numeric value must lie within the hard limit range 
for the modification to be accepted. 

Enumerated parameters can only be set to a discrete set of values.  Enumerated 
parameters can be edited by: 

1. Making a selection from the drop-down list in the cell, 
2. Typing the first letter of one of the possible values (press the same letter 

multiple times to cycle through items that all begin with the same letter), 
3. Pasting a case sensitive matching value. 

Where an invalid letter is entered, or a case sensitive paste value does not match 
the acceptable values, no change will be made. 

Use Alt+Down Arrow to drop down the list of the focused cell. 

Display Units 

All calibrations are initially created by EFILive using metric units. So, when a 
calibration is first opened its data will be displayed in metric. You can change the 
data units and the row and column label units to suit your preference. 

 

You can choose to have calibrations display using US Customary 
units when first opened by setting the appropriate “Default Units” 
option in the Edit->Properties window, like this: 
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. 

Some data values have multiple metric units and multiple US Customary units 
(sometimes incorrectly called imperial). To quickly select the default Metric, US 
Customary or User configured default units for the calibration’s data, click on the 
[Metric], [Custom,] or [User] buttons respectively. 

If the row and column labels have metric/custom options then you can change 
them as well by holding down the Ctrl key to change all three (data, row and col) 
units to the preferred unit system. 

Row/column units can be selected independently by right-clicking on the table and 
selecting the row/column units option. 

Where an alternative unit of measure for a table is not available, the display units 
options will be inaccessible.  If row/column unit options are available, these can be 
modified by right-clicking on the row/column header and selecting the row/column 
units option. 

Calibration Limits  

EFILive enforces two sets of limits on each calibration’s value(s), a hard limit 
set by the controller and a soft limit set by EFILive. 

In some rare cases EFILive will set the hard limits to less that that allowed by 
the controller. For example, some speedometer calibrations should never be 
set below a certain threshold or the controller can fail permanently with divide 
by zero errors that prevent the controller from booting. 

Hard limits cannot be exceeded. 

If any calibration value exceeds the soft limits but not the hard limits, then that 
value is displayed with white corner flashes indicating that the value is outside 
of the soft limits range.  Note: White is the default color for corner flashes 
indicating out of range calibrations, but may be customized to any other color. 

The soft limits are usually the same as the hard limits, except in cases where it 
makes no sense to allow excessively large limits. For example, the spark maps 
in an LS1 controller allow up to 720 degree which is a nonsensical limit for 
spark advance. 

If a calibration file is loaded containing values that exceed the hard limits, those 
values will be coerced so that they lie within the hard limits and reported in the 
“Out of Range” tab page.  EFILive will not permanently alter the "Out of Range" 



EFILive V8 Reference 

support@efilive.com - 46 - www.efilive.com 

values, unless that calibration window is opened and at least one cell value is 
changed. In that case, all cells will be saved with their current “in range” values. 

Calibration Description 

The calibration name and description are displayed here along with links to related 
tables and links to related axis tables. 

Click on links to open calibrations in a new tab. 

Scan-Link 

Scan-Link displays data from the scan tool into a tune tool calibration. 

No Link do not link the scan tool to the tune tool. 

Link to Scan Tool allow a link to be created between the scan tool and tune tool. 

Link to Mouse set the mouse to display cross hairs based on the mouse position. 

Scan Data select one of the currently open log files with which to link. 

Column PID select the column PID to be linked from the log file.  Use the check 
box to include all PIDs in the drop-down list. 

Row PID select the row PID to be linked from the log file.  Use the check box to 
include all PIDs in the drop-down list. 

Select will select all of the linked cells in the calibration. 

Column Value displays the value of the column PID from the selected scan tool 
chart inspector’s instantaneous position. 

Row Value displays the value of the row PID from the selected scan tool chart 
inspector’s instantaneous position. 

Data Lookup Value displays the intersecting value of the column/row from the 
tune calibration. 

Linked cells show the selected frames from the scan tool.  These are displayed in 
aqua when using default colors. 

Runway display is visible whenever the "Link to Scan Tool" radio button is 
selected. It is a visual indicator to the user that scan linking is active.  It shows the 
scan tool chart inspectors instantaneous position when scan tool data is selected.  
If playback is selected in the scan tool, the runway will track the chart inspector 
position.  

If a log file has not been selected the runway sits in the top-most row and left-most 
column.  These are displayed in dark blue when using default colors. 

 

A caveat to runway display is that single column tables look the same as 
mouse-linking by displaying cross hairs rather than column highlights. 

To use Scan-Link; 

1. Open a log file and a tune file. 
2. Open the calibration you wish to link to the scan data. 
3. Select the [Link to Scan] Tool radio button. 
4. Select the log file name in the Data field.  Where multiple log files are 

open, use the drop down to make a log file selection. 
5. Select Column PIDs and Row PIDs. 
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The Scan-Link is now active, you can now playback the data log to watch runway 
tracking. 

Making a selection in the scan tool will link all corresponding cells in the tune tool 
table. Linked cells are shown with different background color. 

Click the [Select] button to select all linked cells, once selected they can be edited 
or copied to the clipboard. 

Virtual VE 

The Virtual VE tab is only visible when Virtual VE style calibrations are open. 

Refer to the Virtual VE documentation for further information. 

Virtual Torque  

Starting with the E38 controller, GM calibrations include a torque model that is 
used by the ECM to compute the engine torque based on 5 inputs: 

1. Exhaust Cam Angle 

2. Intake cam Angle 

3. Spark Advance 

4. Airflow (either airflow in g/cyl or MAP in kPa)  

5. RPM 

The torque model using those 5 inputs can be visualized as the 5-dimensional 
space shown below: 
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The number of virtual tables grows exponentially with each additional dimension 
and/or the size of each dimension. In the image above there are: 

• 4 x Exhaust Cam Angles 

• 5 x Intake Cam Angles 

• 5 x Spark Advance Angles 

The total number of virtual tables is defined by those values multiplied together; 
4 x 5 x 5=120 virtual tables. 

 

The virtual table is selected by choosing the appropriate Exhaust Cam Angle, 
Intake Cam Angle and Spark Advance Angle. To help you keep track of which 
virtual table is being shown, the virtual table number is displayed (highlighted in 
red in the image above) to the left of the [Re-generate 3D Surface] button. 

Use the three track bars to select the appropriate angles. 

The Link checkboxes allow you to automatically apply the same changes that are 
made to the displayed virtual table, to all other virtual tables in that linked 
dimension. For example, if you checked only the Spark Advance Link checkbox, 
then any changes you made to the current virtual table would automatically be 
applied to all virtual tables that have the same exhaust and intake angles but that 
have different spark angles. 

The [Generate Coefficients] button generates the coefficients tables from the 
current data in the virtual torque tables. 

The [Re-generate 3D surface] button first generates the coefficients tables from 
the current virtual torque tables, then re-generates the virtual torque tables from 
those newly generated coefficients. 
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The drop-down option of the [Re-generate 3D surface] button, called “Generate 3D 
surface (from coefficients)” overwrites the existing virtual tables with newly 
generated data from the coefficients. Use this option after copy/pasting coefficient 
data from another calibration. 

User Notes 

Enter comments at a calibration level.  Comments are saved in the calibration 
configuration settings.  User notes are not saved to the tune file. 

Where comments exist on a calibration, the tab heading [User Notes] changes 
to [User Notes *].   

To add User Notes, type in the user notes tab.   

To remove User Notes, delete the data that is present in the user notes tab. 

Provider 

Users may define their own calibrations (or obtain calibrations from other 
tuners) to compliment the calibrations provided by EFILive. In that case the 
user that created the calibration definitions (i.e. the provider of the *.cax8 file) 
should complete the “provider information” in that *.cax8 file.  

If the calibration being displayed/edited is provided by EFILive then the EFILive 
provider information will be displayed. 

If the calibration being displayed/edited is provided by a third party via a *.cax8 
file then the provider information from the *.cax8 file will be displayed. 

Table 

All calibrations’ data is displayed/edited using tables. 

For 2D and 3D calibrations a 2D or 3D graphical representation of the data in the 
calibration may also be displayed as a 2D or 3D chart. 

Focus Cell the cell highlighted in dark blue that indicates where data entry will 
occur. The focus cell is always a selected cell. 

Selected Cells have a blue background by default – the background color of 
selected cells can be customized. 

Linked Cells have a slightly different blue background by default – the 
background color of linked cells can be customized. 

Modified Cells have blue corner flashes by default – the color of the corner 
flashes can be customized. 

Out of Range Cells have white corner flashes by default – the color of the corner 
flashes can be customized. 

 

Colors can be managed in the [Properties] -> Tuning Tool -> Editor in 
the Colors -> Miscellaneous section. 

Click (and drag) with the left mouse button to select cells.  Combine with [Ctrl] 
and/or [Shift] to make multiple selections. 

Editing Data in the V8 Tune Tool Editor 

Click in the Focus Cell to start editing the data in that cell or start typing an 
appropriate value in the cell. 
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Press Esc to undo any changes to the cell and terminate editing. 

Press Enter or Up/Down or some of the other navigational keys (such as Tab, 
Page Up, Page Down, etc.) to terminate the edit and apply that new value to all 
Selected Cells. 

Selecting Data in the V8 Tune Tool Editor 

Select Cells by Dragging 

Left click in any cell (other than the focus cell) and drag the mouse to select a 
rectangular range of cells. 

Click in the top left blank cell to select the entire table, or use the hotkey Ctrl+A. 

Click in any column heading to select the entire row, click+drag vertically to select 
multiple rows. 

Click in any row heading to select the entire column, click+drag horizontally to 
select multiple columns. 

Select Cells without Dragging 

Select a cell or row or column by clicking in a column header or row header, then 
hold down the SHIFT key and click in different cell or a different column header or 
row header to select all cells between the first and second selections. 

Make Multiple Selections 

Make any selection as described above. 

Hold down the CTRL key to start a new selection without clearing the previous 
selection. Any overlapping selection areas will be inverted. 

Keyboard Selections 

Use the arrow keys, Home, End, Page Up and Page Down keys to move the focus 
cell. 

Moving the focus cell (without using either Shift or Ctrl) will unselect all previously 
selected cells.  Hold down the Shift key to select a rectangular region of cells while 
moving the focus cell. 

Hold down the Ctrl key to move the focus cell without unselecting any previous 
selected cells. Any overlapping selection areas will be inverted. 

Press Ctrl+Space to toggle the selection status of the focus cell.  Technically the 
focus cell always remains selected, this option is simply a construct to allow you to 
individually pick/choose which cells are focused and which are not by: 

• Holding down the Ctrl key, and 

• Moving the focus cell using the arrow keys, and 

• Toggling the selected status using Ctrl+Space. 

Column/Row Header Indications on Tables 

The column and row labels will be highlighted to indicate the extent of the current 
selection. The extent of the selection is from the top, left most selected cell to the 
bottom, right most selected cell.  

All column and row labels within that range will be highlighted in grey – not just the 
columns and rows that contain selected cells. The column and row labels of the 
focus cell will be highlighted in blue. 
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Editor Options 

In addition to the various tool bars, a range of right-click mouse options are 
available when the mouse is positioned over the calibration table. Right-click 
options are: 

Task Icon Hot Key 

Undo last change.  Ctrl+Z 

Redo last undo.  Shift+Ctrl+Z 

Select All cells and column/row labels.  Ctrl+A 

Copy/Paste Default Settings   

Copy selected cell(s).  Ctrl+C 

Copy selected cell(s) and column/row labels.  Shift+Ctrl+C 

Copy selected cell(s) as Lua Source.  Ctrl+Alt+C 

Paste   

Copy/Paste Default Settings 

The Copy/Paste Default Settings option is available via the right-click context 
menu.  This option opens a window for user defined copy/paste settings. 

Task Description 

Copy to Clipboard 

Copy Units to 
Clipboard 

Include unit measurements for parameter style 
calibrations. 

Fill Empty Cells  Will fill empty cells using the “weighted, nearest 
neighbor” method before pasting. 

If selected, the clipboard will not contain any 
empty cells, they will have been filled in as the 
data is copied onto the clipboard. 

Precision  Specify the number of decimal places when 
copying numeric data. 
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Paste from Clipboard 

When Pasting with 
Labels 

When pasting with labels, if an exact matching 
row and column cannot be found in the target 
calibration for any cell then that cell is not pasted, 
unless the Interpolate option is checked. 

Interpolate If the Interpolate option is checked and the row 
and/or column labels represent a numeric scale, 
then the data being pasted is adjusted using 
bilinear interpolation. The interpolation stops at 
the boundaries defined by the labels on the 
clipboard, unless the Fill to Edges option is 
checked. 

Fill to Edges Only available when Interpolate check box is 
active.  If the Fill to Edges option is checked, the 
interpolation continues all the way to the four 
edges of the calibration’s table. 

Fill Empty Cells Will fill empty cells using the “weighted, nearest 
neighbor” method before pasting. 

If the clipboard contains empty cells and you have 
"fill empty cells" selected, then the empty cells are 
filled in as they are pasted into the table. 

Combine with Existing Data 

Overwrite 

Add 

Subtract 

Manage the default paste method based on the 
option selected here. 

Multiply 

Correction 

Manage the default paste method based on the 
option selected and the weighting for the 
calculation here. 

Pre-configured Paste Options 

When the mouse is located over a calibration or parameter cell, pre-configured 
paste options are available by accessing the right-click menu.   

Task Description 

Paste 

Paste and Add 

Paste and Subtract 

Paste and Multiply 

Pastes the data cells from the clipboard into the 
calibration starting at the focused cell. The target 
cells are adjusted according to the option selected 
(overwrite, add, subtract, multiply or error 
correction). 

Paste with Labels 

Paste and Add with 
Labels 

Paste and Subtract 
with Labels 

Paste and Multiply 
with Labels 

Pastes the data cells from the clipboard into the 
calibration at the matching row and column 
labels. 

The target cells are adjusted according to the 
option selected (overwrite, add, subtract, multiply 
or error correction). 
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Paste as Error 
Correction 

Paste as Error 
Correction with 
Labels 

This option is usually used to paste error 
correction data recorded by the Scan Tool BEN 
factor MAPs.  The data in the clipboard must be in 
the range 0.0 to 2.0 or it will be ignored. 

The data in the cell(s) is modified by a correction 
factor as follows: 

new = old * (1.0 + ((cb - 1.0) * w)) 

where: 

• new is the cell's new value. 

• old is the cell's original cell value. 

• cb is the value in the clipboard (in the range 
0.0 to 2.0) 

• w is the percentage weight expressed as a 
decimal value between 0.0 and 1.0, where 
0.0=0%, 0.5=50% and 1.0=100% 

Help for Paste 
Options 

Opens detailed Paste help guide. 

Copy/Paste with Labels Examples 

When copy and pasting “with labels” EFILive attempts to copy cells from the 
clipboard to the calibration that have matching row and column labels. 

 

Copying the above data using the “Copy with Labels” option will copy the following 
data to the clipboard (as shown when pasted into Microsoft Excel). 

 

When that same data is pasted back into a different calibration table using any of 
the “Paste with Labels” options, each data cell from the clipboard will be pasted 
into the calibration at the equivalent data cell that has the same row and column 
labels. 
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If the destination calibration has different row and/or column labels, then some 
cells (that have no matching row and column labels on the clipboard) are not 
pasted. 

 

After pasting the data from the clipboard, rows: 2600, 3000 and 3400 were not 
updated with data from the clipboard because there were no cells on the clipboard 
for those row labels. 

If Interpolation is checked, then the data for the missing rows and/or columns will 
be inferred using bilinear interpolation. Bilinear simply means that the interpolation 
occurs in two directions: vertically and horizontally so that both missing rows and 
columns can be inferred. 
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If Fill to Edges is checked, then the interpolation does not stop at the limits of the 
clipboard data, it continues pasting the edge values from the clipboard all the way 
to the edge of the calibration. 

 

Column/Row Label and Unit Options 

When the mouse is located over a calibration or parameter cell, the edit 
column/row label and unit selections are available via the right-click menu. 

Option Description 

Edit Column Axis 
Values  

Opens the axis calibration in a new tab page to 
edit the column label values.  When the axis is 
modified, all calibrations that use the axis are 
automatically updated. 

Change Column 
Units 

Displays a menu of compatible units in which to 
display the column labels. 

The currently selected units are identified by the  
icon.  

Edit Row Axis Values Opens the axis calibration in a new tab page to 
edit the row label values.  When the axis is 
modified, all calibrations that use the axis are 
automatically updated. 

Change Row Units Displays a menu of compatible units in which to 
display the row labels. 

The currently selected units are identified by the  
icon.  
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Calibration Axis 

Some table-style calibrations have axis labels that may be modified by the EFILive 
software. The axis labels are effectively just another calibration that consists of a 
single column of values.  

For example, the E38 {B5101} High Octane Spark Map shown below has both row 
and column axes that may be modified. To modify the row or column axes, right-
click on the table and select either the “Edit Column Axis Values” or “Edit Row Axis 
Values” options. 

 
{B5101} High Octane Spark Map 

Selecting the “Edit Column Axis Values” option will open a new editor tab page 
that contains the calibration {B5100} Spark Airflow Axis. 

 
{B5100} Spark Airflow Axis 

The axis calibration displays the actual axis values as editable calibration data, 
and the [Description] tab page lists all calibrations that rely on this axis calibration 
for either their row or column labels.  

Changing any axis calibration value will cause the axis labels of all those listed 
calibrations to be changed. All calibrations that use the axis will be updated in the 
row or column cell navigator tree to appear as modified as a result of the changes 
to the axis.   
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Some axis calibrations have been defined as visible calibrations in the EFILive 
software and they show up in the navigator tree as selectable calibrations. Those 
axes may be opened by selecting them from the navigator tree or by using the 
right-click options described above. 

Other axis calibrations that have not been defined in the EFILive software do not 
show up in the navigator tree. Those calibrations may only be opened using the 
right-click options described above. 

Both types of axes may be located using the navigator search. 

Curve Tools 

The curve fitting tool is most useful for single column calibrations (but can be used 
on 3D tables). It allows you to specify 3 or more data points and then fit a curve 
through those points.  Curve fitting is most effective when non-selected cells exist 
between three or more selected cells. 

The following Curve options are available: 

Task Icon Hot Key 

Fit curve to selected cells options.  Shift+F10 

Fit curve horizontally – a minimum of 3 cells must 
be selected. 

  

Fit curve vertically – a minimum of 3 cells must 
be selected. 

  

Fit curve horizontally and vertically – a minimum 
of 3 cells must be selected. 

  

The curve fitting slider adjusts the weight of the curve.  When the slider is all the 
way to the left the curve fits exactly through the selected points. When the slider is 
moved to the right the curve becomes more and more straight until at the right 
edge the best straight-line fit is made. 

Moving the slider will display the proposed curve and proposed cells values based 
on the slider position.  Select [OK] to apply the changes to the table.  Select 
[Cancel] to discard the proposed curve values. 

The values of all cells along the curve will be adjusted, not just the selected cells. 

On 2D graphs, square points are selected points, and round points are non-
selected points. 

 

Curve Tools is a significant feature enhancement to the V8 Editor.  It 
replaces the Blending options in the V7 Tune Tool.  
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For example, the LS1B {B5001} MAF Sensor Map images shown below curve 
options. 

This image is a stock LS1B MAF curve. 

 

To generate a custom MAF curve to suit a unique/custom MAF design, users 
would typically log a few data points using an air-flow measuring system to 
generate a result like this. 
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Previously the only option was to use the gradient tool on each "section, but it only 
generates straight lines. 

 

Select the airflow points that were measured by holding Ctrl while selecting the 
cells with the mouse.  (Note the data points change from round to square when 
selected).  
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Use the curve fitting tool to generate a curve through those points. 

 

Smoothing 

Smoothing is a process that removes the sharp peaks and troughs from a data 
series or surface map. Smoothing is designed to be applied after any modifications 
have been made.  

Three smoothing options exist;  

Task Icon Hot Key 

Smooth selected cells horizontally – a span of at 
least 3 columns must be selected. 

 Shift+F11 

Smooth selected cells vertically – a span of at 
least 3 rows must be selected. 

 Shift+Ctrl+F11 

Smooth selected cells horizontally and vertically 
– a span of at least 3 columns/rows must be 
selected. 

 Shift+Alt+F11 

For example, the three CME {E2781} Main Timing Map images shown below 
contain varying degrees of smoothing.  Smoothing was applied over the entire 
table (all cells) using the horizontal and vertical smoothing tool. 
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Gradient  

Gradient is used to create straight lines between two points in row or column data, 
or both row and columns. 

 

The V8 gradient feature was known as Linear Fill in V7 Tune Tool 
software. 

Three gradient options exist. 

Task Icon Hot Key 

Make horizontal gradient – a minimum of 3 cells 
must be selected. 

 Shift+F12 

Make vertical gradient – a minimum of 3 cells 
must be selected. 

 Shift+Ctrl+F12 

Make rectangular gradient – a minimum of 3 cells 
must be selected. 

 Shift+Alt+F12 

For example, the four CME {E2781} Main Timing Map images shown below 
demonstrate the different gradient options. 
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Clip Selected Cells 

Clip is designed to crop selected cells to be less than or greater than a specified 
value. 

Two clip options exist. 

Task Icon Hot Key 

Clip selected cells to maximum.   

Clip selected cells to minimum.   

To Clip cells, select a range of cells, enter the clip value into the Adjust box and 
apply the clipping tool. 

For example, the E67 {B5101} High Octane Spark Map images shown below 
demonstrate clip options. 
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Comparing Two Calibrations 

EFILive provides a rich set of calibration comparison tools. By loading in two 
calibrations from the same controller family, you can compare the differences (or 
similarities) of calibrations. 

The tune files do not need to be from the same operating system nor from the 
same controller, but they must be from the same controller family. 

The controllers on the same line in the table below are compatible and tune files 
from those controllers may be compared. If a controller is not listed, it is not 
compatible with any other controller. 

E37, E38 and E67 

E39 and E39A 

E80, E81 and E82 

E83A and E83B 

E35A and E35B 

E86A and E86B  

E87A and E87B 

T87 and T87A 

When comparing two tunes using the compare  option, the original tune is 

defined as the   CAL calibration and the tune opened via the compare  option 

is defined as the  ALT calibration. 

Only values in the CAL calibration can be modified and saved.  ALT calibration 
data is used for reference and for copying data only and cannot be modified.  Cell 
modification and tool bar buttons are disabled when the ALT calibration or any of 
the comparison displays are visible. 

The compare icon  displays all calibration comparison results in a single tab.  To 
ensure correct results, comparisons are computed and displayed using metric 
values only. 

Custom Operating Systems are not compared nor displayed in the compare tab 
page. 
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Use the filter options at bottom of table to select display options.  

Icon Description 

  Show calibrations that have identical checksums. 

 Show calibrations that have different checksums. 

 Show calibrations that contain identical data, identical axis and 
identical pairing. 

 Show calibrations that have different data content. 

 Calibrations that have different axis sizes and/or axis label values. 

 

Calibrations with different axes are detected and 
identified in the comparison tab page.  

However, when viewing the data, the CAL axes are 
used to display both the CAL data and the ALT data. 
The ALT data is interpolated (re-mapped) to fit 
accurately within the CAL axes. Refer to the 
Interpolation example later for a more detailed 
explanation. 

By using the same axis for both a more accurate and 
useful comparison is shown. 

 

 Calibrations that only exist in the CAL calibration. 

 Calibrations that only exist in the ALT calibration. 

The following range of right mouse click options exist: 

Select All (Ctrl+A); selects all calibrations that are currently displayed. 

Copy (Ctrl+C); copies the selected calibration(s) or folder(s). 

Update (Ctrl+U); updates the selected calibration(s) or folder(s) to the 
value(s) in the alternate file. NOTE: The checksum and unpaired calibrations 
items cannot be updated. 

Expand All; expands all folders in the compare tab. 

Collapse All; collapses all folders in the compare tab. 

Double click on a calibration to open that calibration in a new tab. Use the 
Compare toolbar buttons to move between the CAL and ALT files. 

Show Calibration Differences the  icon displays differences in cell values 
between the CAL and the ALT files.  Where the value in the CAL and ALT files are 
identical the difference will display as an empty cell.  The calibration difference 
cannot be modified. 

Show Relative Percentage Differences the   icon displays relative percentage 
differences in cell values between the CAL and the ALT files.  The difference is 
calculated as ((CAL-ALT)*100)/ALT.  Where the value in the CAL and ALT files are 
identical the difference will display as an empty cell.  The calibration difference 
cannot be modified. 
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Show Absolute Percentage Differences the   icon displays absolute 
percentage differences in cell values between the CAL and the ALT files.  The 
difference is calculated as ((CAL-ALT)*100)/(max-min)..  Where the value in the 
CAL and ALT files are identical the difference will display as an empty cell.  The 
calibration difference cannot be modified. 

 

If a calibration is listed on the Compare tab with different data but a 
variance cannot be seen between the CAL and ALT values, try 
increasing the displayed precision to show the variance. 

Update an entire calibration to alternate values by selecting the [Update] button in 
the Compare tab. 

The re-compare icon  refreshes the status of all calibrations in the Compare tab. 
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Interpolation during calibration comparison 

When two calibrations are being compared that differ in the number of rows or 
columns or differ in the values of the row or column labels the comparison is 
implemented using interpolation. 

The Compare tab displays calibrations with different axis sizes or labels with the 

 icon. 

For example, the E67 {B5101} High Octane Spark Map images shown below 
demonstrate how interpolation is used to compare tables with different axes. 

This image is a stock High Octane Spark Map. 

 

When an engine is running the ECM retrieves values from this table using an x-y 
lookup, i.e. it uses the current value for g/cyl (for example 0.20 g/cyl) and the 
current rpm (for example 200) to determine the row and column of the desired 
spark advance cell. The spark advance value for those two values is 30.0. 

But what if the g/cyl value was in-between two existing labels? I.e. what if the g/cyl 
value was 0.26 g/cyl, half way between the existing labels of 0.24 and 0.28. 

The spark value returned would then be halfway between the values that 
correspond to those labels, i.e. (28.5+21.5)/2 = 25.0 

What if the rpm was 300? In that case bilinear interpolation must compute three 
linear interpolations as follows: 

1. linear interpolation between the two air values for rpm 200 (i.e. between 
28.5 and 21.5 = 25.0), and the  

2. linear interpolation between the two air values for rpm 400 (i.e. between 
29.0 and 21.5 = 25.25), and finally the  

3. linear interpolation between those two values: 25.0 and 25.25 = 25.125 

Using interpolation, we can translate the data from one table into the data of 
another table that has different row and column labels.  Using the High-Octane 
Spark Map above,  

The CAL tune contains the following data: 

 

The ALT tune contains the following data (with different column labels): 
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The compare function cannot compare the cells at the same col/row index 
between those two tables above because the data is for different axis labels.  

So, a third table is constructed that uses the same axis labels as CAL and then the 
values from ALT are copied into the third table using bi-linear interpolation to 
compute the correct values for each of the labels. The computed ALT table is 
shown below.  The orange cells exist in both CAL and ALT and the green cells are 
computed using bi-linear interpolation for the ALT display: 

 

Convert Data Between Units 

 

The Convert tab page provides a data conversion tool that can be used to convert 
data between various units. It is most useful when importing/exporting data to 
other applications that may use slightly different data layouts and formats. 

Access the Convert tab by selecting the  icon, or using the Ctrl+Alt+Enter hot 
key. 

Select from and to units to be converted.   

Enter sample conversion values in the Value fields to test the outcome of the units 
selection.  

Create New Table requires that the data on the clipboard was created using the 
Copy with Labels option. A new table with the same dimensions and labels as the 
clipboard data will be created. 

Convert Table will convert the data in the table from the From units to the To 
units. 

Selected Cells only will convert only the selected cells not the entire table, unless 
the entire table is selected. 

Speedometer Calculator 

Manufacturers employ various methods to capture road speed and display it to 
the driver. Because of the wide variety of speedo implementations, the speedo 
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calculator is not designed to, and cannot “magically” correct or recalibrate the 
speed settings for every type of vehicle/controller. It is a tool that can calculate 
various, interdependent calibrations that you may need when calibrating your 
vehicle’s speed settings. The results from the speedo calculator may not be 
relevant for your particular application. Some manufacturers use more than one 
way to determine the vehicle’s speed and more than one way to calibrate 
various features that rely on the vehicle’s speed (such as transmission shift 
points, ABS, radio volume, steering sensitivity, etc.). For example, the 
speedometer display may be independently calibrated within the instrument 
cluster, the ABS system may use multiple speed sensors from multiple wheels, 
independently of the ECM’s vehicle speed sensor. It is up to the tuner to 
determine exactly how the vehicle’s speed is captured, calibrated, transmitted 
and displayed, as those things will usually be different for different platforms. 

Most controllers supported by the EFILive Tuning Tool use a Vehicle Speed 
Sensor (VSS) that is located on either the drive shaft or the drive axle. Where 
the speed sensor is located determines whether the differential ratio affects the 
VSS signal or not. 

The vehicle speed sensor sends a stream of pulses to the controller. The pulse 
frequency increases proportionally as the road speed increases. The controller 
needs to know how many pulses will be received in one mile (or one km if you 
are working in metric). This calibration term is called pulses per mile or pulses 
per km. 

To display the Speedometer Calculator, select the  icon from the file 
management task bar. 

Each of the five Speedometer Calculator tabs contains these options: 

Metric and US Custom Select your preferred unit of measure.  Updating the 
unit of measure selection in one tab will update the selection in all tabs.  

[Reset] button re-loads the calibrated values from the tune file for the 
current tab page only. 

[Apply] button applies changes on the current tab page to the tune file. 

[Close] closes the Speedometer Calculator window. 

Tire Size 

Values in the Tire size calculator are color coded to assist users in determining 
the origin of those values: 

User Supplied Values are yellow and display values that have been 
changed by the user. 

Calculated Values are green and indicate values that have been 
calculated by EFILive software. 

Calibrated Values are blue and indicate values that have been loaded 
from tune file. 

Tire Size: Enter tire width, profile and rim diameter. Click the calculate button 

 to calculate the values in the Tire Calibration section using the values 
entered in the Tire Size section. 
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Tire Calibration: Enter either tire diameter, or tire circumference, or tire 

revolutions. Or, click the calculate button  to calculate the values in the Tire 
Calibration section using the values in the Speedometer Calibration section. 

Transaxle: Uncheck this option for vehicles with a speed sensor fitted to the 
drive shaft between the transmission and the differential. Check this option for 
vehicles with a speed sensor fitted to the transaxle. Most vehicles with a 
transaxle (e.g. the Corvette) have a vehicle speed sensor fitted to the 
transaxle. 

Diff Ratio: The differential ratio. 

TOS Revs: The number of revolutions of the transmission output shaft (TOS) 
per the selected unit of measure. This value may not be used in vehicles with 
manual gearboxes and may be set incorrectly (in the 800 to 899 range) for 
some factory manual calibrations. 

VSS Pickup Teeth: The number of teeth on the vehicle speed sensor. For GM 
vehicles, this value is usually 17 or 40. Generally, most manual cars use 17, 
most automatic cars use 40. Manual and automatic Corvettes use 40. Most 
trucks use 17. 

Pulses /TOS Revolution: The number of pulses transmitted to the PCM per 
revolution of the transmission output shaft. This value may not be used in 
vehicles with manual gearboxes and may be set incorrectly in some factory 
manual calibrations. 

Pulses/km or mile: The number of pulses transmitted to the PCM per mile or 
per km. 

Sprocket Ratios 

The 4T60-Eand 4T65-E transmissions contain two chain driven sprockets. 
These sprockets may have varying number of teeth. The number of teeth is 
commonly 33, 35 and 37, however that may not always be the case. 

Using EFILive’s Sprocket Ratio calculator, you can determine the Sprocket 
Ratio and Calculated Diff Ratio. 

Drive Sprocket: The number of teeth on the drive sprocket. 

Driven Sprocket: The number of teeth on the driven sprocket. 

Sprocket Ratio: The ratio of driven sprocket to drive sprocket. 

Transmission Diff Ratio: The ratio of the differential gears fitted to the 
transmission. 

Calculated Diff Ratio: The effective differential ratio that is used for speedo 
calculations. 

[Copy to “Diff Ratio”] copies the Calculated Diff Ratio value to the “Diff Ratio” on 
the Tire Size tab.   

Speedo Fine Tuning 

If the speedometer is incorrect by only a few mph or km/h, use this calculator to 
calculate the required change. 

Displayed Speed: The speed displayed on the speedometer. 
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Actual Speed: The speed measured independently (i.e. via GPS).  

Correction Required: The percentage correction required. 

New VSS Pulses is the new vehicle speed sensor pulses per mile/km. 

Shift Point Correction 

Changes made to tire and diff settings may cause the transmission shift points to 
change. To allow EFILive to automatically adjust the shift points, select the shift 
tables that EFILive should update and then click [Apply]. 

Original Calibration Values: Enter the original Tire Diameter and Diff ratio, or 
select [<-] to reset to original values. 

New Calibration Values: Enter the new Tire Diameter and Diff ratio, or select [<-] 
to reset to user supplied values. 

Adjust by is the percentage correction required. 

Use the  icon to add calibrations to be adjusted. 

Use the  icon to remove calibrations from the list to be adjusted.  

Use the  icon to import the shift point correction calibration list for the current 
tune file’s controller type from V7.  

Setup 

Controller displays the controller type from the open tune file. 

[Set All to Default]: Sets all supported calibration names to their EFILive defaults. 

Pulses/km or mile: Enter calibration name or use the [<-] to set to H0101. 

Pulses/TOS Revolution: Enter calibration name or use the [<-] to set to H0102. 

Final Drive Ratio: Enter calibration name or use the [<-] to set to H0103. 

TOS Revolutions/km or mile: Enter calibration name or use the [<-] to set to 
H0104. 

Sprocket Ratio: Enter calibration name or use the [<-] to set to H0116. 

Tire Revolutions/km or mile: Enter calibration name or use the [<-] to set to 
H0136. 

Tire Circumference: Enter calibration name or use the [<-] to set to H0139. 

[Remove All Invalid Names] removes all calibration names that are not 
supported in the current tune file. 

These setup values and the shift point correction table names are stored in the file: 
\Documents\EFILive\V8\Config\speedo_adjust.ini 

Custom Operating Systems 

Custom Operating Systems provide support for additional functions not supported 
in OEM files.  Custom Operating Systems exist on specific controllers and specific 
operating systems.  Refer to the relevant Custom Operating System document for 
coverage details. 

Where custom operating systems are available, they will be located in the 
Navigator as a calibration segment folder.  The exact location is dependent on 
controller type and custom operating system type. 
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The complexity of the function determines the EFILive method of implementation.  
Two different methods exist to apply Custom Operating Systems. 

Parameters are located under the Operating Systems Patches folder in the 

navigator and denoted by the  icon. 

The function is enabled by changing the value of the parameter.  These functions 
immediately apply the change to the tune file, update the navigator icons and the 
calibrations modified since last save list. 

COS Upgrades are located under either the Operating Systems Patches folder or 

COS Upgrade folder in the navigator and are denoted by the  icon on non-
upgraded tune files.  EFILive hardware does not need to be detected for COS 
Upgrade options to be visible. 

 

In the V7 Tune Tool, Custom Operating System Upgrades were located 
on the Calibration Window as an independent tab, not in the navigator. 

In the V7 Tune Tool, EFILive hardware had to be connected to view and 
upgrade COS patches.  This is not a requirement in the V8 Editor.  

The function is applied by clicking the Apply Upgrade button, saving the tune file, 
closing the tune file and finally opening the file that was most recently saved.  

 

 Custom Operating systems using the COS Upgrade method do not 
change icon format in the navigator window when applied because 
they cannot be undone/redone. 

 Custom Operating systems using the COS Upgrade method do not 
show as modified calibrations in the modifications since last save 
window because they cannot be undone/redone. 

Once the upgraded file is reopened, the vehicle operating system number will be 
upgraded to an EFILive Custom Operating System number and additional tuning 
parameters will be available for editing under the EFILive Custom Calibrations 

folder located at the top of the navigator.  The folder path and the  icon(s) 
displayed in the OEM file will no longer be available because the operating system 
is upgraded. 

Where multiple  COS Upgrade options are available, only one can be applied.  
To apply a different COS Upgrade option, the upgrade process must start with a 
standard operating system base file. 

To remove a custom operating system, a tune file with an OEM operating system 
number must be full flashed into the controller. 
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Cax8 

User defined calibrations are managed in the Editor using Cax8 files.  Cax8 files 
are plain text files that can be incorporated into the tune tool to add additional 
tables and/or parameters for editing.  This feature requires very detailed and 
specific knowledge regarding the location and definition of the controllers’ data.  
Incorrect definition of parameters may render the controller unresponsive. 

 

EFILive will support the integration between Cax8 and the Editor.  

EFILive does not offer customer service support or assistance for 
parameter definition within Cax8 files.   

If a controller becomes unresponsive after being flashed with a tune 
file created and/or edited while a cax8 file was active in the V8 
software, EFILive will not provide a replacement VIN license under 
the VIN License Replacement Policy. 

Cax8 files must adhere to the layout and design criteria documented in the 
template located in the \Documents\EFILive\V8\User Defined Cax8\Template.cax8 
file. 

 

To be correctly loaded, a *.cax8 file MUST start with the same name as 
the EFILive supplied *.cam file that is loaded for the target tune file. 
Usually the *.cam file name is the operating system number, however 
some controllers do not; specifically: 

• Allison transmission calibrations use the calibration ID instead of 
the operating system number.  

• Cummins calibrations use a modified operating system number. 
So be careful to choose the correct file name for your *.cax8 file. 

You can view the EFILive supplied *.cam file name in the [Provider] tab 
page of any EFILive defined calibration.  You may have multiple *.cax8 
files for a single operating system, so long as the *.cax8 filename starts 
with the same name as *.cam file loaded by the EFILive software. To be 
correctly loaded, a *.cax8 file MUST start with the same name as the 
EFILive supplied *.cam file that is loaded for the target tune file. Usually 
the *.cam file name is the operating system number, but for some 
controllers, such as AL5 and A40, the cam file name is different to the 
operating system number. You can view the EFILive supplied *.cam file 
name in the [Provider] tab page of any EFILive defined calibration.  You 
may have multiple *.cax8 files for a single operating system, so long as 
the *.cax8 filename starts with the same name as *.cam file loaded by 
the EFILive software.  

i.e. with names like: 

• 12619078.cax8 

• 12619078_Spark.cax8 

• 12619078_AirFlow.cax8 

If/when a tune file is opened with an operating system of 12619078, all 
of those *.cax8 files will be loaded. 

To prevent naming conflicts, the cax8 author should define a Unique ID 
in the cax8 file. Failing to provide a Unique ID will result in the EFILive 
software providing a default Unique ID in the range U00..U99. 
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All values and units in this cax8 file MUST be specified using metric units and the 
metric units must valid units as defined in the V8 software under the Edit-
>Properties->General->Units tab page. 

When the calibration is displayed, the user can select the actual display units. So, 
for example if a calibration is defined using km/h, then when the calibration is 
displayed, the user will be presented with all other speed related units such as 
mph, feet/sec, meters/second etc. The user can choose to display the calibration 
in any of those preferred units, and the V8 software will automatically convert the 
displayed values to the selected units. 

 

When you are developing a *.cax8 file and you are cycling through the 
edit->save->edit->save process, you can force the V8 editor to reload 
the newly saved *.cax8 file by using the hot key combination Ctrl+Alt+X. 
That hotkey will close all open editor tab pages and reload all *.cax8 
files for the current operating system. 

Flashing 

Try Stock Keys See Reading Calibrations for explanation of this item. 

Try This Key See Reading Calibrations for explanation of this item. 

Try Common Alternative Keys See Reading Calibrations for explanation of this 
item. 

Try Key Range (Cal-Flash only) allows you to specify a range of keys to attempt 
to unlock E38, E40, E67, LS1B, E54 (LB7) and E60 (LLY) controllers. 

Use this option if you know the controller is locked and if you do not know the key 
that was used to lock it.  Large key ranges may take over 100 hours to find correct 
key.  Keys may be entered in decimal (1..65535) or in hexadecimal 
($0001..$FFFF). 

Keys are tried in a random order in the range specified. If you need to pause or 
end the process, select the [Quit] button which saves the current status of the 
unlock process. To restart the unlock process, ensure the [Restart] option is 
checked prior to selecting [Cal Flash] to continue processing from the previously 
saved point. 

 

Once the key is found, the controller is erased, then unlocked, then 
left in dead-poll mode. The key is not revealed. A Cal-flash with a 
compatible operating system is required to restore ECM functionality 
(or a full flash if changing operating systems). 

Assume Lock May Be Faulty See Reading Calibrations for explanation of this 
item. 

Try Additional Unlock Strategies See Reading Calibrations for explanation of 
this item. 

High Speed (VPW Only) See Reading Calibrations for explanation of this item. 

Dodge Cummins Fast CAN Mode (for CMD, CME, CMF controllers only)  

Unlimited Fast CAN delivers the fastest possible flash time and is approx. 
50% faster than standard flash routines.   

Fast CAN is a little faster than standard, but more robust than Unlimited.  



EFILive V8 Reference 

support@efilive.com - 74 - www.efilive.com 

Standard use this option if you experience flash failures when using Unlimited 
Fast Can or Fast CAN. 

Perform Test Flash Only will simulate the flash process, complete with full data 
transfer to/from the controller. Use this option to test whether a flash will be 
successful or not without risking the integrity of the controller. Test flashing neither 
erases the flash memory nor programs any new data into the controller, therefore 
it is safe to interrupt a test flash, and even a test full-flash can be safely 
interrupted. For the same reason, test flashing is not able to test for correct battery 
voltage. If your battery voltage is too high or too low then the erase or flash may 
fail. 

VAT Relink Ign. Cycles will set the ignition cycles required before VAT relink 
occurs.  If 0 then the ignition cycle counter will not be modified. (LS1B, E54 and 
AL5 only) 

Recover PCM (LS1B only) Recover PCM’s NVRAM with data from the currently 
loaded tune file. (LS1B only) 

Reset Allison TAPS (AL5 Only) Reset Allison Transmission Adaptive Pressures 
(TAPs) at completion of full-flash. (AL5 only) 

Allison VIN Restore VIN to this value when full-flashing an Allison (AL5) 
controller. 

Check License will communicate with the controller and check the controller’s 
licensed status. 

Activate License will license controller to FlashScan/AutoCal device. 

Cal Flash will start the calibration only flash process. Calibration flashing only 
changes the calibrations in the controller and not the operating system. A 
calibration flash can be interrupted without rendering the controller inoperable. 

Full Flash will start the full flash process. Full-flashing changes the operating 
system and the calibrations. 

 

A full flash cannot be safely interrupted for older style controllers (e.g. 
LS1, L31, E54, E60, AL5 and all Pxx controllers). Interrupting a full-
flash has a high probability of rendering those controllers inoperable 
and unrecoverable. If a full-flash is interrupted on the older style 
controllers, restart the full-flash process as soon as possible without 
removing power from the controller. 

Quit will stop the cal-flash or full-flash process. Do not interrupt the full-flash 
process. If you absolutely must interrupt a full-flash process, please wait until it is 
more than 20% complete. See next section for more information on how to recover 
from a failed flash. 

What causes a failed flash? 

When a controller is re-flashed, EFILive performs the following steps: 

1. Unlock the target controller. 
2. Request other modules on the network be silent and respect the re-flash 

process. 
3. Download a proprietary boot-loader program, designed and written by 

EFILive into the target controller (not all controllers require a bootloader). 
4. Erase the target controller. 
5. Reprogram the target controller. 
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Any of those 5 steps could fail for many different reasons. Below are some of the 
common reasons why each of those steps could fail. 

Unlocking may fail because: 

• The controller has been locked with a custom key by you or by some other 
tuner. In that case you must supply the key to the EFILive pass-thru 
software prior to reading or flashing the controller.  

• The controller’s security system has been damaged or is non-functional. In 
that case please check the “Try Alt Keys” and “Assume Lock May Be 
Faulty” check boxes and retry the flash process. 

• The controller’s security system has been modified by a non-EFILive tuner 
to use a different unlock strategy. In that case contact EFILive support and 
we will attempt to help you unlock the controller using the “Try Additional 
Unlock Strategies” option. 

• The controller is not the correct controller. Trying to unlock one type of 
controller using another type of controller’s key will fail and report that the 
controller is locked. 

• Cummins controllers may contain an RSA digital signature and/or a 
Security Gateway module that needs to be addressed before flashing can 
commence.   

Silencing modules on the network may fail because: 

• Some aftermarket modules do not honor the request to be silent. In that 
case, please disconnect or disable all aftermarket electronic modules by 
removing their fuse or power supply. Typical culprits are radios, navigation 
systems, phone systems and other entertainment systems. 

• FlashScan/AutoCal V3 users can access a range of test modes to check 
the network for rogue modules that may cause read or flash operations to 
abort are available by navigating to the Tune Tool -> F1: Tuning -> F4: Test 
OBD Network menu. 

Downloading the boot-loader may fail because: 

• One of the above failures occurred. 

Erasing the controller may fail because: 

• The boot-loader was not downloaded correctly. 

• The vehicle’s battery voltage is out of range. The battery voltage must be 
close to 12V. 

• The erase command can take up to 60 seconds. During that time if any 
other module starts to transmit on the network the erase may not complete 
successfully.  

• A cable has become disconnected. 

Reprogramming the controller may fail because: 

• The vehicle’s battery voltage is out of range. The battery voltage must be 
close to 12V. 

• The reprogramming command can take up to 10 minutes. During that time if 
any other module starts to transmit on the network the reprogramming may 
not complete successfully. 

• A cable has become disconnected. 
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What should I do if the flash process fails? 

Calibration only flash 

A calibration-flash failure is not critical and will generally not result in an 
unrecoverable controller. To recover from a failed calibration only flash, turn the 
ignition off, wait 30 seconds, turn the ignition back on, wait a further 10 seconds, 
the retry the calibration only flash. 

If the calibration only flash continues to fail: 

1. Remove battery power from the controller, by either removing the 
controller’s fuse or by disconnecting the battery from the vehicle. 

2. Wait 30 seconds. 
3. Reconnect power. 
4. Retry the calibration only flash. 

Full flash 

A full flash failure is critical and may result in an unrecoverable controller. To 
attempt to recover from a full flash failure please follow the controller specific 
instructions: 

For controllers that are any of the following: 

GM Gas GM Diesel 

LS1A Gen III 97-98 PCM E54 LB7 Duramax ECM 

LS1B Gen III 99-08 PCM E60 LLY Duramax ECM 

L31 Vortec 98-00 PCM AL5 Allison 5 Speed TCM 

All Pxx controllers  

A full flash failure may cause these controllers to be rendered inoperable and 
unrecoverable. If a failure occurs while full flashing one of these controllers. 

 
DO NOT REMOVE POWER FROM THE CONTROLLER. 

As long as the controller remains powered up, EFILive’s proprietary boot loader 
running in the controller will continue to wait for a successful full flash procedure. 
Simply retry the full flash procedure until it is successful. 

If, for some reason power is removed from the controller the only other chance of 
recovery is that the original failed flash actually made it to about 15%-20% 
complete. In that case the operating system and communications code may have 
been restored enough to allow the controller to continue to operate in dead poll 
mode. 

 

Retry the full flash procedure, if it fails with “no communications” error 
then the controller has probably been rendered inoperable and 
unrecoverable. The only way to recover the controller is to disassemble 
it and physically remove, reprogram and replace the flash chip on the 
main circuit board. 

For all other controllers: 
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A full flash failure will generally not render these controller inoperable since the 
controller’s built in boot block is not erased and will continue to allow the controller 
to be reprogrammed after the failure. To recover from a full flash failure, retry the 
full-flash process again. 

If the full-flash continues to fail: 

1. Remove battery power from the controller, by either removing the 
controller’s fuse or by disconnecting the battery from the vehicle. 

2. Wait 30 seconds. 
3. Reconnect power. 
4. Retry the full flash. 

Where device and controller restrictions are implemented on the tune file, an 
unrestricted stock tune should be full flashed. 

If calibration or full flashing continues to fail, please see this knowledgebase 
article: https://service.efilive.com/kb/articles/problem-flashing-a-controller 

Controller Information 

Displays Controller VIN, Operating System, Controller Code and Controller Serial 
details are displayed. 

Controller VIN can be changed here. 

Security Restrictions 

Calibration security can be used to control how your calibration file(s) can be used 
by others. You can enable or disable a host of restrictions to suit most 
requirements. 

Master FlashScan License 

The security settings cannot be changed unless a FlashScan device is connected. 
The connected FlashScan’s license number is copied into the “Master FlashScan 
License” field. Once the file has been saved, the security settings can only be 
changed/cleared when that same FlashScan (or a FlashScan with the same 
license number) is connected. 

Clear All Security Restrictions removes tune file security when that same 
FlashScan that applied the security is connected. 

Load All Security Restrictions From Another File (Ctrl+L) automatically applies 
security from another tune to this file where the controller type matches.  Security 
changes can only be saved with FlashScan connected. 

Load All Security Restrictions and Remote Settings From Another File 
(Ctrl+Alt+L) automatically applies security and remote settings from another tune 
to this file where the controller type matches.  Security changes can only be saved 
with FlashScan connected. 

Calibration Privacy 

Calibration privacy relates specifically to the calibration parameters of the tune file.  
This does not extend to non-calibration data such as checksums, VIN, or remote 
key options.  

Can be Viewed and Modified allows anyone who has the tune file to display and 
modify the calibration contents of the file. 

https://service.efilive.com/kb/articles/problem-flashing-a-controller
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Can Only be Viewed allows anyone that has the file to view the calibration 
contents file but not to modify it. 

Cannot be Viewed or Modified means that anyone who has the file cannot view 
the calibration contents of the file and therefore cannot modify it either*. 

*Note: Tunes with the restriction “cannot be viewed or modified" have their 
comments and modification history erased to prevent the recipient from viewing 
that information. 

Encryption 

To securely encrypt a tune file a FlashScan V3 must be connected.   When saving 
a file with encryption the save process may take up to 60 seconds.  Once 
encrypted, the file cannot be re-opened in the V7 or V8 software, it can only be 
Black-Box flashed.   

Once the Securely Encrypt File checkbox is selected, the Calibration Privacy is 
automatically adjusted to cannot be viewed or modified.  All other security options 
remain available for use.  

For Use With V2 and/or V3 Devices allows the encrypted file to be flashed with 
V2 and V3 devices. 

For Use With V3 Devices Only allows the encrypted file to be flashed only with 
V3 devices. 

More Info displays encryption help. 

Reflash Security 

Can be Calibration-Flashed or Full-Flashed means the file can be either 
calibration-only flashed or full flashed into controllers that support either of those 
two options. 

Can Only be Calibration-Flashed means the file can only be used as a 
calibration-only flash. It cannot be used to full flash a controller. 

Can Only be Full-Flashed means the file can only be used as a full flash. It 
cannot be used to calibration-only flash a controller. 

Auto-Lock controller during flashing means the target controller will be locked 
with a secret key that prevents the calibration from being read out of the controller. 
To unlock the controller it must be flashed with a tune file that does not have this 
option checked. Usually a stock file is used for unlocking duties. 

 

Auto-Locking is available on selected controllers.  The [Supported 
Controllers] button on the [Security Restrictions] tab lists controllers 
available for Auto-Locking. 

Device and Controller Restrictions 

Device License restricts the tune file to being flashed only by devices that have 
this license number. 

Device Serial restricts the tune file to being flashed only by the single device that 
has this serial number. 

Controller Serial restricts the tune file to being only flashed into the controller that 
has this serial number. 
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Controller VIN restricts the tune file to being only flashed into controllers that 
match the VIN pattern supplied. A VIN pattern may use a dot to indicate “don’t 
care” characters. All other characters must match the target VIN. 

For example, the VIN pattern: ”6G1......6.......” will match ONLY VINs 

that start with the three letters “6G1” and that also have a “6” at position 10. 

Clear All Security Restrictions 

To clear all security settings and to remove the FlashScan License number, click 
the [Clear All Security Settings] button while the correct FlashScan device is 
connected. 

Clear all security settings will not remove Auto-Lock restriction where Auto-Lock 
was set via the EFILocker COS Patch, or reset the AutoCal Remote License. 

Remote Control 

As the author of a tune you can choose to implement a variety of Remote Control 
options using the [F4: Properties] menu item and selecting the [Remote Control] 
tab. 

Options for Remote Reading and Flashing 

Various remote options can be embedded in a *.ctz or *.coz tune file to be used to 
control remote Black Box Flashing.  These are ignored during pass-thru flashing.  

Security Access 

[Try this Key] allows a key to be entered to gain access the controller during BBF.  

The key is encrypted before being stored in the file. 

[Try Key Range] See Reading Calibrations for explanation of this item. 

[Clear Key] removes the key from the file. 

Try Common Alternative Keys forces FlashScan/AutoCal to try additional known 

keys to gain access to the controller. 

Assume Lock May Be Faulty See Reading Calibrations for explanation of this item.  

Protocol Options 

High Speed (VPW Only) attempts to flash the controller using high speed mode (the 

default value for this option is “checked”). 

Dodge Cummins Fast CAN Mode (for CMD, CME, CMF controllers only) See 
Flashing Calibrations explanation of this item. 

 

The options for remote flashing are only used when black box flashing 
(i.e. in standalone mode). When using pass-thru flashing these options 
are ignored and the equivalent pass-thru flashing options are used 
instead. 

Full-Flash Options 

VAT Relink Ign. Cycles will set the ignition cycles required before VAT relink 
occurs.  If 0 then the ignition cycle counter will not be modified.  (LS1B, E54 and 
AL5 only) 

Recover PCM (LS1B only) Recover PCM’s NVRAM with data from the currently 
loaded tune file. (LS1B only) 

Reset Allison TAPS (AL5 Only) Reset Allison Transmission Adaptive Pressures 
(TAPs) at completion of full-flash. (AL5 only) 
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Allison VIN Restore VIN to this value when full-flashing an Allison (AL5) 
controller. 

AutoCal Remote License 

Remote License shows that the tune file may be used by any remote AutoCal 
device that is linked to the remote license number shown. To set the remote 
license, use one of following drop down options on the [Save] button: 

• Save, For AutoCal 

• Save As, For AutoCal 

• Save (Calibration Only), For AutoCal 
 

 

Where device and/or controller restrictions are implemented, tuners 
should provide an unrestricted stock tune to assist in ECM recovery of a 
failed flash. 

File Information 

Comments 

Allows users to store comments and notes about the tune file.   

 

Tune files saved with the restriction “cannot be viewed or modified" 
have their comments erased to prevent the recipient from viewing this 
information. 

History 

EFILive automatically keeps a history of all changes made to the calibration. You 
may edit the history data; search for text or for particular dates. 

 

Tune files saved with the restriction “cannot be viewed or modified" 
have their history erased to prevent the recipient from viewing this 
information. 

Version/Author 

File Version and Author created/modified details are found here, where Author 
details are setup in the Edit -> Properties -> General -> User Info menu. 

Calibration Source 

Records EFILive Software version, Device type and read method, Script version, 
Firmware and Boot Block versions. 

GM Controller Locking/Unlocking 

Locking refers to the security system built into most vehicle controllers. Most 
controllers' security systems employ a simple seed/key system to prevent 
unauthorized access to the controller's operating system and/or calibrations. 

Many tuners like to protect their tunes by locking the controller. 

Due to the very different controller architectures that have been released between 
1998 and 2021, locking has been implemented differently for different controllers.  
In some instances only specific operating systems are supported for locking.  
Controller locking on 2017+ model year vehicles is not available due to GM 
security changes.  
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The GM Controller Locking Guide provides specific details on how to apply 
locking. 

What GM Controllers can be Locked? 

GM Gas 

Controller Locking method 

E381 Auto Lock via BootLocker, or Manual locking. 

E39/E39A1 2 Auto Lock via EFILocker Patch. 

E40 Auto Lock via BootLocker, or Manual locking. 

E67 Auto Lock via BootLocker, or Manual locking. 

E781 2 Auto Lock via EFILocker Patch. 

E801 2 Auto Lock via EFILocker Patch. 

E921 2 Auto Lock via EFILocker Patch. 

LS1B Auto Lock via BootLocker, or Manual locking. 

GM Diesel 

Controller Locking method 

E54 Auto Lock via BootLocker, or Manual locking. 

E60 Auto Lock via BootLocker, or Manual locking. 

E981 2 Auto Lock via EFILocker Patch. 

Transmission Controllers 

Controller Locking method 

A50 Auto Lock via EFILocker Patch. 

T431 2 Auto Lock via EFILocker Patch. 

T871 2 Auto Lock via EFILocker Patch. 

1 Where the controller remains in use in 2017+ model year, or was released during 
or after 2017, locking is not available due to GM security changes. 

2 Select Operating Systems only; refer to GM Controller Locking Guide for further 
information. 

 Auto Locking 

Auto Locking is an EFILive exclusive feature that allows tuners to automatically 
lock controllers when flashed with a protected tune file and to automatically unlock 
controllers when flashed with a non-protected tune file where the tune file was 
locked using V8.2.2 build 225 software (June 2013) or later. 

When an ECM is Auto-Locked all non-EFILive reflashing tools (such as GM's Tech 
II) will be prevented from reading and flashing the controller.  However EFILive’s 
Tuning Tool will always be able to reflash the ECM.  Depending on the Auto-Lock 
status of the file being flashed, the ECM will either remain locked or be unlocked at 
the completion of the flash. 
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The Auto-Lock system generates and manages its own keys to ensure that any 
EFILive user can reflash an Auto-Locked controller. Because the keys are 
managed internally and are never exposed to the user, the controller cannot be 
unlocked manually by supplying the key. 

Auto-Locking is implemented using two distinct methods, dependent on the 
controller type.  The two methods are: 

1. BootLocker. 
2. EFILocker COS Patch. 

Locking via BootLocker 

BootLocker can be used to lock/unlock controllers during a calibration only-flash or 

a full-flash procedure by selecting the Auto-Lock security setting in the V8 Tune 

Tool.  

Auto-Locking the controller via BootLocker can be applied to a tune file using: 

• V8 Scan and Tune using the [F3: Tune] -> [F4: Properties] via the [Security 
Restrictions] tab. 

• V8 Scan and Tune via the [F5: BBX] -> [F6: Quick Setup]. 

Locking via EFILocker COS Patch 

EFILocker COS Patch must be applied to the tune file and requires a full-flash 
procedure to take effect in the controller.  Where the controller remains in use in 
2017+ model year, locking is not available due to GM security changes. 

Auto-Unlock  

Where the controller was locked using EFILive’s Auto-Lock technology, the 
controller can be unlocked by any FlashScan or AutoCal in the following situations: 

Auto-Lock using BootLocker Remove the Auto-Lock security setting in the tune 
file and calibration only-flash or a full-flash the controller. 

Auto-Lock using EFILocker Remove the Auto-Lock security setting in the tune 
file and full-flash the controller.   

Manual Unlock 

Historically, locking involved the tuner setting a manual key, and the controller 
could not be read or flashed unless that key was known.  For controllers locked 
using a manual key, or controllers locked using software other than EFILive 
software, the following options exist to unlock a controller during a calibration only-
flash or full-flash procedure. 

Try Stock Key See Reading Calibrations for explanation of this item. 

Try This Key See Reading Calibrations for explanation of this item. 

Try Common Alternative Keys See Reading Calibrations for explanation of this 
item. 

Try Key Range (Full Flash only) See Reading Calibrations for explanation of this 
item. 

Assume Lock May be Faulty See Reading Calibrations for explanation of this 
item. 
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Try Additional Unlock Strategies See Reading Calibrations for explanation of 
this item. 

Controller Authorization 

Process Retirement 

In January 2021, EFILive implemented a method where the EFILive software now 
manages the Controller Authorization process from end to end for 
FlashScan/AutoCal V3 and FlashScan/AutoCal V2 devices. 

Where FlashScan/AutoCal V3 and/or FlashScan/AutoCal V2 is updated, an Auth 
Code purchase is not required.  

There are significant time savings for tuners and end users. Auth codes no longer 
need to be transferred between tuners and end users, and a secured controller 
that has not yet been unlocked will now read completely in a single step process. 

This is a free enhancement for all customers who update their software and 
firmware to the January 2021 software release or later. 

Historical Process 

Please refer to the Controller Authorization.pdf document for the historical process 
first released in 2016. 

Scripting 

Making automated or repetitive changes to tune files can be accomplished by 
scripts.  Scripting can be used to read tune file and controller information, as well 
as modify items including comments, history, tune file security settings and remote 
settings as well as reading/modifying calibration data. 

The Lua scripting language and runtime interpreter is used by the EFILive V8 
software to implement scripting. A range of example scripts are included in the 
\Documents\EFILive\V8\Scripts folder.   Detailed documentation on how to script 
construction and application is located in the EFILive Command Line 
Reference.pdf. 

The ten most recent used scripts are listed in the Script drop down. 

To compile and test the script for syntax errors select [Compile]. 

Scripts can only be applied to open, unrestricted tune file.  Any restrictions should 
be applied after the script is applied. 

The [Run] function will apply the script to the tune file, or the script can be saved 
for later use and applied via the EFILive Command Line Interface. 

To display success or error messages when compiling or running a script the 
Show Output option should be selected. 

Where a script is applied, any changes made to the tune file cannot be undone.  
Changes that may have already been made to the security settings, comments or 
history will not be available until the tune file is saved. 

For example, using E67 {B5102} Low Octane Spark Map a script can be created 
ensure that each cell in the low octane spark map is always less than the 
equivalent cell in the high octane spark map.  If the lower cell is greater than or 
equal to the high cell then the low cell is set to one less than the high cell.   

The script to compare and execute these changes is in the image below. 

https://content.efilive.com/documents/Controller%20Authorization.pdf
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After running the script, Low Octane Spark Map is modified. 
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F4: OBD 

Buttons 

Tune 

Next Tune Window (Alt+3) will make the Next Tune Window the focus window. 

New Tune Window (Ctrl+Alt+3) will open a New Tune Window. 

Tune Window will list the open Tune Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Scan 

Next Scan Window (Alt+2) will make the Next Scan Window the focus window. 

New Scan Window (Ctrl+Alt+2) will open a New Scan Window. 

Scan Window will list the open Scan Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Config 

Config (Alt+Enter) opens the EFILive Property Settings window at the Display 
category. 

Close 

Close (Ctrl+F4) closes the Window.  

Controller Information 

F2: OBD 

[Read] (Ctrl+R) Displays various OBD (On Board Diagnostic) data that can be 
read from the controller, including: 

• Controller information and segment part numbers. 

• System Readiness Tests. 
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• Diagnostic Trouble Codes 

• CVNs (Calibration Verification Numbers). 

[Clear] (Ctrl+C) Clears diagnostic trouble codes and test results. 

[Legend] (Ctrl+L) Displays explanation of diagnostic trouble code status. 

Details Displays controller information including controller type, VIN, and operating 
system information. 

Tests Displays Systems Rediness test results. 

DTCs Displays the status of DTCs 

VIN Change Retrieves and Reprograms the VIN. 

VAT Relink Reset the VAT (Vehicle Anti-Theft) for auto linking with the BCM. 

F3: Lookup DTC 

This option can be used to lookup diagnostic trouble codes. 

 

FlashScan and AutoCal provide an option to capture ALL diagnostic 
data from a connected vehicle into a single text file report in 
standalone mode.  

Select FlashScan’s menu option: F3 Diagnostics -> F4 Record All 
Diags. 

Select AutoCal’s simple menu option: Record Diags. 

Select AutoCal’s advanced menu option: Trouble Codes->Record 
Diags. 

F4: Lookup OS 

This option can be used to lookup GM Operating System compatibility. 
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F5: BBX 

Buttons 

Tune 

Next Tune Window (Alt+3) will make the Next Tune Window the focus window. 

New Tune Window (Ctrl+Alt+3) will open a New Tune Window. 

Tune Window will list the open Tune Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Scan 

Next Scan Window (Alt+2) will make the Next Scan Window the focus window. 

New Scan Window (Ctrl+Alt+2) will open a New Scan Window. 

Scan Window will list the open Scan Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Open 

Open (Ctrl+O) will open a configuration file. 

Save 

Save (Ctrl+S) will save the configuration file with its current name. 

Save As (Alt+S) will save the configuration file with a new name. 

Save Quick Setup (Shift+Ctrl+S) will save the current quick setup configuration 
file. 

Save Quick Setup As…(Shift+Alt+S) will save a quick setup configuration file 
with a new name. 

Save Quick Setup As (Read Only)… will save a quick setup configuration file 
with a new name and make the file read-only. That means the file can’t be 
accidentally modified unless the read-only flag is removed. To remove the read 
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only flag: Using Windows Explorer, right click on the quick setup file and select 
“Properties” then uncheck the “Read-only” check box. 

Read 

Read (Ctrl+R) reads the current configuration from the attached device. 

Program 

Program (Ctrl+P) Programs the attached device with the current configuration 
and any supporting files that have been updated since the device was last 
programmed. 

Program Selections Only (Faster) programs the attached device with only the 
configuration file. This option should only be used if you have only changed PID 
selections. If you have changed the number and or type of controllers for either 
scanning or tuning then you should use the Program or Program All Required Data 
options. 

Program Selections and Configuration Files (Slower) formats and then 
programs the attached device with all configuration files regardless of whether 
they are out of date or not. 

Format CONFIG File System formats the CONFIG file system in which the 
configuration and supporting files are stored. When making significant changes to 
the BBX options, it is a good idea to format the CONFIG file system to discard any 
old/unused files prior to programming. 

 

To save CONFIG file space you may also elect to exclude the DTC 
description files from FlashScan devices. In that case FlashScan will 
only be able to display DTCs but not their descriptions. 

DTC description files are not copied to AutoCal V2 DTC devices. 

Close 

Close (Ctrl+F4) closes the Window. If any changes have been made and not yet 
saved you will be asked to save the changes. 

Standalone Operation (BBX) 

Standalone operation (aka BBX) is used to describe the operations that FlashScan 
and AutoCal devices can perform without being connected to a laptop or PC. 

Before any BBX operations can be performed, the device must be configured with 
the appropriate data files. The data files that are copied to the device are: 

• Options.txt: contains the options that you have selected to be available via 
BBX, such as which controllers to enable, which PIDs to log, which DTC 
descriptions will be available and the switchable tune names. 

• *.pmm files: contain the PID definitions for each controller that you have 
selected for BBL. 

• *.obj files: contain the read and flash configurations for each controller that 
you have selected for BBR and/or BBF. 

• *.bix files: contain additional read and flash configurations for some 
controllers that you have selected for BBR and/or BBF. Not all controllers 
require the *.bix files. 
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For advanced users, it is possible to use EFILive Explorer to manually copy the 
necessary configuration and support files from \Program Files\EFILive\V8\Config\ 
to a FlashScan or AutoCal device, however it is much easier and more accurate to 
use the [F5: BBX] setup option in the EFILive Software. 
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EFILive Explorer showing BBX configuration files for the E92 controller 

 

Many of the configuration files are intimately linked to FlashScan’s and 
AutoCal’s firmware version. Use the [Check Firmware] button in the 
main EFILive Scan and Tune Window to update the firmware and 
associated configuration files. 

Quick Setup 

V8 Scan and Tune [F5: BBX] -> [F6: Quick Setup] tab page provides a complete 
BBX configuration profile that can be used to configure a device in one easy step.  
Quick setups are most often used by tuners to create a single configuration file 
that they can email to their customers to allow their customers to quickly and 
easily configure an AutoCal device.  Quick setups are not limited to AutoCal 
devices, they can also be used to configure FlashScan devices. 

Create a new quick setup file using the New Quick Setup button. 

Open an existing quick setup file using the Open Quick Setup button. 

Program the quick setup into a device using the Program Quick Setup button. 

Save a new quick setup file using one of the three drop down options on the 
[Save] button.  

A black box quick setup file (*.bbx) contains copies of all the configuration data 
and tune files required to configure the AutoCal device.  All necessary data and 
files are copied into the quick setup file when it is saved. 

The data that is copied into the quick setup file is: 

• The device settings that are currently configured in the [F6: Devices] window. 
You can modify the device settings by clicking on the [Edit AutoCal Settings] 
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button on the [F6: Quick Setup] tab page.  FlashScan device settings can be 
modified by selecting the [Edit FlashScan Settings] item on the drop down box on 
the [Edit AutoCal Settings] item. 

• The current file which contains the controllers and PID selections that are 
currently configured in the [F5: BBX] window. 

• All required supporting configuration files (*.obj, *.pmm, *.bix and *.dtc). 

• Various options that are to be performed when the user programs the quick setup 
configuration in to their device: 

o Format the CONFIG file system before copying BBX configuration 
files to device will as the description suggests format the CONFIG file 
system. It is recommended that you check this option to ensure all old 
configuration files are removed from the target device. 

o Delete all existing tune files before copying new tune files to device 
will delete all existing *.ctz and *.coz files from the /EFILive/Tune folder of 
the target device. 

o Overwrite existing tune files when copying new tune files to device 
will automatically and without any warning, overwrite existing files on the 
device.  It is recommended that you check this option otherwise if a file 
already exists on the device then it will not be copied from the quick setup 
to the target device. 

• Up to 10 *.ctz and/or *.coz tune files can be added to the quick setup 
configuration. To add one or more tune files to the quick setup 

configuration, click the  button. To remove selected tune files, click 

the  button. 

Quick Setup.bbx files can be emailed to your end user to program or reprogram 
AutoCal.   

Quick Setup.bbx files should be saved in the folder: \My 
Documents\EFILive\V8\BBX 

Tuners and end users will need to manage file names and the appropriate back up 
of files, particularly for tune files should multiple Quick Setup configurations be 
required.  

Tuners should provide instructions to end users on how to program Quick Setup.bbx 
files based on the configuration changes made.   

Quick Setup Security Restrictions: 

You can select one or more tune files and right click to modify the various security 
attributes of the tune files as well as the file name. Modifying these attributes does 
not alter the original tune file, it only alters the copy of the file that is stored in the 
Quick Setup file. 

The padlock icon next to the tune file name displays the security restrictions status 
of that file.   

If the padlock icon is locked for a tune file, then you cannot modify the security 
restrictions for that file. You must reset the security restrictions before you can set 
new restrictions. To reset security restrictions, the Master FlashScan device that 
was used to enable current security settings must be connected to your PC.   

The security restrictions status padlock is only updated when a Quick Setup file is 
saved or when a file is converted from *.ctz to *.coz. 
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There are a variety of security settings available using the right click option on one 
or more tune files. 

 

Select All – allows all files in the Quick Setup to be selected at once. 

Rename – allows a single file to be renamed. 

Quick Setup Properties – manages multiple file security settings via the 
“Quick Setup Properties” window, where both Security Restrictions and 
Remote Control options can be managed. 
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Security Restrictions 

Security can either be set by selecting individual components under 
each section heading, or via selecting Security Restrictions Defaults 
which lists a range of pre-defined options that are available. 

Detailed descriptions for each individual component are documented 
under Calibration Security. 

Remote Control 

Detailed descriptions for each individual component are documented 
under Remote Control section listed earlier in this document. 

Security Restrictions Defaults - manages single file or multiple file security 
settings via a range of pre-defined options that are available. 

 

Where multiple files are selected, and security restrictions are not compatible 
across all files, the Quick Setup will automatically adjust security levels to the 
‘next applicable’ security level. The following message will be displayed. 

 

Reset Security Restrictions – removes security settings on single file or 
multiple file selections.  The Master FlashScan device that was used to enable 
any current security settings must be connected to your PC.   

Resetting security restrictions WILL NOT reset the Remote License field.  
Remote License is not a security restriction.  A Remote License is an enabler 
that allows an AutoCal to flash tunes created by a particular FlashScan.   

Resetting security restrictions WILL NOT remove Auto-Lock controller during 
flashing where the Auto-Lock was set via the EFILocker COS Patch. 

Link to Remote AutoCal – enables an AutoCal to flash tunes created by a 
particular FlashScan.  This is not a security restriction.  

Remove Link to Remote AutoCal – removes the remote AutoCal license, 
disabling the file from being flashed by any AutoCal device.  
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Set Device License to FlashScan’s License Number - restricts the tune to 
being flashed only by FlashScan devices that have the same License Number. 

Convert *.ctz file(s) to *.coz file(s) – converts *ctz file(s) to *.coz file(s) where 
*.coz file formats are supported for the controller type selected.  If the 
controller type does not support *.coz file format, the file(s) will remain in *.ctz 
format.  Files cannot be converted from *.coz format to *.ctz format. 

Export Tune File(s) - If you accidentally lose or delete the original *.ctz tune 
files that were used to create a quick setup file, you can recover them using 
this option. 

NOTE: When you change the security restrictions of files in the quick setup 
list, those restrictions are not applied immediately to the files. Instead, security 
restrictions are only applied to the files in the quick setup list when the quick 
setup file is saved. 

 

EFILive recommends at least the following settings for AutoCal 
quick setup tune files: 

• Private 

• Lock (Auto-Locking is available on selected controllers.  The 
[Supported Controllers] button on the [Security Restrictions] tab 
lists controllers available for Auto-Locking.) 

• Device License (to prevent un-authorized FlashScan’s from 
flashing tunes). 

• Master License (to implement file security). 

• Remote AutoCal License (to give AutoCal ‘permission’ to flash 
tunes created by a particular FlashScan). 

 

Should Quick Setup files be saved without appropriate settings, the following 
warning messages will be displayed during the [Save] process: 
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Tuners have the ability to select [Back] and modify the Quick Setup, or select 
[Continue] after selecting one of the available check boxes.  Selecting [Continue] 
will allow the Quick Setup to be saved in its ‘unsecured’ format.  

Should collective tune file sizes exceed 6MB, the following warning message will 
be displayed during the [Save] process: 

 

Tuners have the ability to select [Back] and modify the Quick Setup, or select 
[Continue] after selecting one of the available check boxes.  Selecting [Continue] 
will allow the Quick Setup to be saved. 

Should Quick Setup files be programmed into AutoCal where tune file(s) are not 
licensed for use with that device, the following warning message will be displayed: 
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Standalone Data Logging (BBL) 

 
 [F5: BBX] option showing E38 BBL PID selections 

The [F2: Scan] page is divided into three regions: 

1. BBL Enabled Controllers shows which controllers are selected for Black 
Box Logging. 

2. Available PIDs for the currently highlighted controller. 
3. Selected PIDs for the currently highlighted controller. 

BBL Enabled Controllers 

To add a new controller, click on the  button or right-click and select “Add”, or 
press the hotkey Shift+Ctrl+Ins. 

 
Scan Controller Properties, LS1 controller selected 

Caption 1 and Caption 2 contain the text that will be shown on FlashScan’s or 
AutoCal’s data logging selection menu. On FlashScan the two captions are 



EFILive V8 Reference 

support@efilive.com - 97 - www.efilive.com 

displayed on a single line with a space separating them, on AutoCal the two 
captions are displayed on two separate lines. 

Some controllers (such as the LS1B) are capable of controlling both the engine 
and automatic transmission. In that case, use the Auto checkbox to indicate 
whether or not an automatic transmission is present. That will ensure the PIDs 
displayed in the Available PIDs area are for the correct transmission type. 

If you allocate a hotkey (F1...F4) to this controller, then you may select this 
controller for data logging duties on FlashScan by pressing that hotkey on 
FlashScan’s keypad. Hotkeys are not supported on AutoCal. 

If you are currently connected to your vehicle, you may click [Auto Detect] to 
attempt to identify the controller(s) in your vehicle, otherwise right-click on the 
shaded squares to select the appropriate engine/transmission controllers. 

Where PID validation has previously been performed for other operating systems, 
you can select one of those previously validated operating systems from the "PIDs 
Valid For Engine OS" or "PIDs Valid For Trans OS" drop down lists. 

To remove a controller from the list, click the  button or right-click and select 
“Delete”, or press the hotkey Shift+Ctrl+Del. 

 

Deleting will delete all highlighted controllers and all their selected 
PIDs.  
To retain the selected controllers and their selected PIDs while 
preventing the controllers from being visible in the FlashScan or 
AutoCal menus, uncheck the checkbox next to the controllers. 

To move the highlighted controllers up or down in the list click on the  and  
buttons respectively or press the hotkeys Shift+Ctrl+UpArrow or 
Shift+Ctrl+DownArrow respectively. 

To select V7 compatibility options click on the  button. The V7 compatibility 
options allow you to specify the V7 dashboard that will be automatically loaded 
if/when you open the data file in the V7 software. You can also add V7 calculated 
PID names that will be automatically displayed if/when you open the data file in the 
V7 software. Calculated PIDs are not computed nor displayed by FlashScan or 
AutoCal in BBL mode. 

To modify an existing controller selection, click on the  button or right-click and 
select “Properties” or press the hotkey Shift+Alt+Enter. 

Available PIDs 

The list of available PIDs is slightly different for most controllers. Each time you 
highlight a different controller in the BBL Enabled Controllers section the PIDs 
shown in the Available PIDs section may change. 

 

The list of available PIDs is divided into a number of groups displayed 
with blue headings. You can configure the display to automatically 
expand all the groups via: Properties->Scan->Dashboard->Expand PID 
Selection Groups Automatically. 

To help locate a specific PID, you can enter all or any part of the PID’s name, 
description or units into the “Search:” text box at the bottom of the window. When 
you stop typing into that text box EFILive will search for and display only those 
PIDs that match the search text. For example, if you were looking for a PID that 
had something to do with spark, then you should enter the text spark.  
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Click the  button to clear the search options and display all PIDs again. 

Selected PIDs 

To include PIDs in the data log, you must “select” them. To select PIDs, highlight 
them and drag them from the from the Available PIDs section to the Selected PIDs 
section, or click the  button or press the hotkey Ctrl+Ins. 

To unselect PIDs, highlight them and click the  button or press the hotkey 
Ctrl+Del. 

You can highlight multiple PIDs at once by left-clicking on them in combination 
with the Ctrl or Shift keys. Holding the Ctrl key down while left-clicking will allow 
you to select multiple individual PIDs. Holding the Shift key down while left-clicking 
will allow you to select a range of PIDs. Only PIDs that are in the same group can 
be selected at once. 

 

Known Issue: 

FlashScan V2 and AutoCal V2 BBL use the *.efi logging file format.  If 
you are logging PIDs from an ECM and TCM simultaneously and you 
have selected a PID from the transmission controller (TCM) that has 
an identically named PID in the engine controller (ECM), then when 
the log file is loaded back into the V8 software for viewing, that TCM 
PID will be displayed as if it originated from the ECM. 

This restriction does not apply when logging in *.pld file format as 
used during V8 pass-thru logging or BBL with FlashScan/AutoCal V3. 

Customizing PIDs 

PIDs may be customized to display different units on FlashScan’s or AutoCal’s 
display and/or to activate alarms on FlashScan based on limits that you set. 
Alarms are not supported on AutoCal V2. 

 
PID Properties showing custom units (mph) and alarm for vehicle speed PID 
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The “Hold” time option is not available yet. When implemented, that option will 
cause the FlashScan or AutoCal display to display the value that triggered the 
alarm for a pre-determined number of seconds, while continuing to log data in the 
background. 

Standalone Reading and Flashing (BBR/BBF) 

 
[F5: BBX] option showing BBX Read/Flash Controller selections 

BBR/BBF Enabled Controllers 

To add a new controller, click on the  button or right-click and select “Add”, or 
press the hotkey Shift+Ctrl+Ins. 

 
Tune Controller Properties, LS1B controller selected 

Caption 1 and Caption 2 contain the text that will be shown on FlashScan’s or 
AutoCal’s data logging selection menu. On FlashScan the two captions are 
displayed on a single line with a space separating them, on AutoCal the two 
captions are displayed on two separate lines. 
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If you are currently connected to your vehicle, you may press [Auto Detect] to 
attempt to identify the controllers in your vehicle, otherwise right-click on the 
shaded squares to select the appropriate engine/transmission controller. 

To remove a controller from the list, click the  button or right-click and select 
“Delete”, or press the hotkey Shift+Ctrl+Del. 

 

Deleting will delete all highlighted controllers.  

To retain the selected controllers and their selected captions while 
preventing the controllers from being visible in the FlashScan or 
AutoCal menus, uncheck the checkbox next to the controllers. 

To move the highlighted controllers up or down in the list click on the  and  
buttons respectively or press the hotkeys Shift+Ctrl+UpArrow or 
Shift+Ctrl+DownArrow respectively. 

To modify an existing controller selection, click on the  button or right-click and 
select “Properties” or press the hotkey Shift+Alt+Enter. 

Switchable Tune Names 

DSP5 (Duramax 5 option switch), DSP4 (E98 4 option switch) and CSP5 
(Cummins 5 option switch) tunes can be switched on the fly from a FlashScan or 
AutoCal device. Enter the names of the switchable tunes that you want to appear 
on FlashScan/AutoCal switchable tunes menu. 

DTC descriptions 

FlashScan is capable of reading trouble codes. Trouble codes are displayed as 
codes with an option to display a description of the trouble code. This section 
allows you to select which trouble code description file(s) you want copied to your 
FlashScan device. The description files are relatively large and will take up space 
on FlashScan that could otherwise be used for configuring more controllers. If you 
find that all the controllers you need configured will not fit on FlashScan, you can 
uncheck one or more of these description files to prevent them from being copied 
to FlashScan. 

 

AutoCal V2 cannot display DTC descriptions. 
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F6: Devices 

Buttons 

Tune 

Next Tune Window (Alt+3) will make the Next Tune Window the focus window. 

New Tune Window (Ctrl+Alt+3) will open a New Tune Window. 

Tune Window will list the open Tune Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Scan 

Next Scan Window (Alt+2) will make the Next Scan Window the focus window. 

New Scan Window (Ctrl+Alt+2) will open a New Scan Window. 

Scan Window will list the open Scan Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Open 

Open (Ctrl+O) will open a device settings file. 

Save 

Save (Ctrl+S) will save the device settings file with its current name. 

Save As (Alt+S) will save the device settings file with a new name. 

Read 

Read (Ctrl+R) reads the current device settings from the attached device. 

Program 

Program (Ctrl+P) Programs the attached device with the current device settings. 
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Close 

Close (Ctrl+F4) closes the Window. If any changes have been made and not yet 
saved you will be asked to save the changes. 

PC-Based Configuration 

Device settings can be managed via [F6: Devices] tab page.  For ease of use for 
tuners who manage remote customers, device settings can also be managed via 
the Quick Setup. 

Both menu options perform the same functions, however the Quick Setup option 
allows for device settings, along with scan and tune configurations, and tune files 
to be collated as a *.bbx file and emailed for remote installation into 
FlashScan/AutoCal.  The [F6: Devices] option only manages device settings, other 
BBX settings require independent configuration.   

[F2: General]   

Target Device Allows the configuration to be programmed into FlashScan and 
AutoCal or restricts the configuration to the selected device. 

File System Configures FlashScan V2 to use either internal memory or SD card. 

File Number Set the sequence number for the next FlashScan/AutoCal generated 
file name.   

Date format Configures date to US Style or Australian Style. 

Timing Set time frame to enable Low Power mode when the device remains 
connected but unused for a set period of time, and set Splash Screen display 
times. 

LED Mode Set LED’s to illuminate to indicate operational status, indicate PID 
range alarms, or none. 

[F3: Display]   

Units Sets Metric or Custom display units. 

Inverse Display Choose screen color combination of White on Blue or Blue on 
White for FlashScan V2. 

Data Logging Sets number of PID's per page display for FlashScan V2. 

Contrast Adjusts the contrast for FlashScan V2 with a blue case. 

[F4: Keypad] 

Keypad Auto Repeat Sets the time delay before a key begins to auto-repeat, and 
the time delay between repeated key strokes in milliseconds. 

Display Timeouts Sets the time that alerts and errors messages are displayed in 
milliseconds for FlashScan and AutoCal. (0 = User must respond to message).  

[F5: Options] 

AutoCal V2 Menu Set display as Simple Menu or Advanced Menu, set Splash 
Screen text for AutoCal V2 devices. 

Custom Menu Install, Enable or Disable Custom Menu selections for FlashScan 
V3 and AutoCal V3 devices.  Custom Menu instructions are located in the C:\ 
\Documents\EFILive\V8\User Defined Menus/SampleCustomMenu.txt file. 
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FlashScan Check SD card space and enable data protection for SD card.  Use 
“S1” (12V switch) to remotely start/stop data logging, and set audible alert when 
starting and stopping data logging using the “S1” switch. 

Common Settings Use EFILive's FAST CAN Mode to set flashing speed.  This 
option can make flashing GM controllers twice as fast.  For Dodge Cummins, 3 
flash speed options are available.  

[F6: Logging] 

PID Selection Allows users to re-select the most recently used PID list, and/or 
automatically select all external analog/digital PIDs. 

External Analog/Digital Inputs Configure the Filter level.   

Data Set Logging speed rates for FlashScan V2 and AutoCal V2 only. 

Notes Automatically add “Note 30’ to log file when log file is paused/resumed. 

[F7: BBX] 

Black Box Logging Allows the choice to validate or skip validation prior to starting 
BBL for FlashScan V2 and AutoCal V2. 

Black Box Reading and Flashing Provides options to enable/disable  

Perform extended verification of uploaded file (can take up to 60 seconds).  
Checks that the uploaded file is complete and encoded correctly. 

Display OBDII retry statistics after Read/Flash is complete. Displays the type 
and number of retries requested during a Read/Flash session. 

Display folders when selecting tune files for flashing.  Tunes placed in custom 
folders without this option selected will not display on FlashScan or AutoCal.  For 
tuners who place tune files in custom folders, those files will only be accessible on 
AutoCal when this option is selected and AutoCal is using the Advanced menu.  
Tunes placed in custom folders will not display in the Simple menu.   

Automatically save trace files if read or flash fails.  Trace files are an essential 
tool in assisting remote customers who have read/flash failures.  The trace file is 
automatically generated and saved onto AutoCal provided enough space exists on 
the devices [Data] file system.  EFILive recommends this option be enabled on all 
devices used for remote tuning. 

Black Box Options Display Switchable tune selections on AutoCal V2 simple menu.  
For tuners who do not provide switchable tune selections, this option can be disabled 
from the Simple menu. 

[F8: Serial I/O] 

Serial Com Port Setup Set the device connected to FlashScan’s RS232 serial 
port.  Supported devices are Wide Band and External Data Logger. 

Wide Band Display Layout Set the Wide Band controller configuration and the 
Wide Band data display format for FlashScan V2. 

Wide Band Type Select the type of Wide Band device connected to FlashScan’s 
serial port, and configure the ID's for multiple ECM AFR wide band controllers. 

FlashScan V3 and AutoCal V3 Configuration 

There are various menus that allow configuration changes to be made on 
FlashScan/AutoCal V3 devices. 
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[Options] -> [F1 Setup] -> [F1 Configuration] 

F1 Edit Settings 

Option Description 

Display Theme Set the color theme for the display 

Font Size Set the font size for the display.  Font size does not 
control fonts in balloon boxes. 

Locale Locale USA or Locale Non-USA. 

Time Format Set time to 24 hour or am/pm. 

Display Units Metric or Custom. 

Key Repeat Delay Not yet available. 

Key Repeat Speed Not yet available. 

Splash Time Set value in milliseconds. 

Low Power Time Not yet available. 

Next File Number Set the sequence number for the next automatically 
generated file name. 

Add Note on 
Pause 

Automatically add a note to log file when log file is 
paused/resumed using [OK]. Set to Yes or No. 

CAN Baudrate Set CAN speed. 

VPW Speed Set VPW speed. 

LED Mode Set to Status or Off. 

COM Port Type Set the device connected to serial port.  Supported 
devices are Wide Band O2, External, or None. 

Set WO2 Type Select the type of Wide Band device connected to 
serial port*.  

Set WO2-1 ID  Configure the ID's for multiple ECM AFR wide band 
controllers. 

Set WO2-2 ID Configure the ID's for multiple ECM AFR wide band 
controllers. 

Set Stoich  Set the stoichiometric value for the fuel that is being 
used. 

For Innovate’s wide band controllers, the stoich value 
can’t be set using this option, instead it must be set 
using Innovate’s Logworks software. 
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Log Serial PIDs Log external digital (i.e. Wide Band Serial) PIDs. 

Load MRU PIDs Not yet available. 

12V Switch Log Connect 12V to start logging.  Disconnect 12V to stop 
logging.  Set to Yes or No. 

12V Switch Beep Only active when 12V Switch Log is active.  

Two short beeps indicate start, one long beep 
indicates stop.  Set to Yes or No.  

Verify BBR Perform extended verification of uploaded file.  Set to 
Yes or No. 

Check BBX Space Check available BBX space before copying files.  Set 
to Yes or No. 

Save Trace Files Automatically save trace file for read/flash errors.  Set 
to Yes or No. 

GM Fast Use EFILive’s Fast CAN mode which can make CAN 
flashing twice as fast.  Set to Yes or No.  

Cummins BBF Set Cummins flash speed as Unlimited, Fast, or 
Standard. 

 

Additional FlashScan Device Settings are available in the follow menus 

F3 Date/Time 

Adjust date and time settings. 

F4 Update Boot Block 

Update the boot block manually. 

[Options] -> [F2 File System]  

F1 Explore 

Allows users to browse files and view free and used space available on 
FlashScan/AutoCal V3. 

F2 Manage 

Delete Files, Format Data File System and Format Entire SD card from these 
options. 

F3 USB Thumb Drive 

Turn FlashScan/AutoCal into a USB thumb drive so you can use Windows 
Explorer to manage the files on the device’s SD Card. 
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FlashScan V2 Configuration 

There are various menus that allow configuration changes to be made on 
FlashScan V2. 

[F4 Options] -> [F1 Setup] 

F1 Edit Settings 

Option Description 

File sys Configures FlashScan V2 to use either internal 
memory or SD card. 

File # Set the sequence number for the next AutoCal 
generated file name. 

Locale Locale USA or Locale Non-USA. 

Units Metric or Custom. 

MRU PIDs Load Most Recently Used PID’s.  Set to Yes or No. 

ScanRate Manage Logging Speed.  Set to Fast, Medium or 
Slow. 

CAN Baud V2 light-duty (blue/black) units have a fixed baud rate 
and cannot be changed. 
V2 heavy duty (red) units can be changed between 
default, 250K and 500K. 

Sw Log Use “S1” (12V switch) to remotely start/stop data 
logging. 

Sw Beep 
Set audible alert when starting and stopping data 
logging using the “S1” switch. 

ADFilter Average this many samples of external analog PID 
data. Set value between 1-4. 

A/D PIDs Automatically select all external analog PIDs. Set to 
Yes or No. 

Ser PIDs Automatically select all external digital (serial) PIDs.  
Set to Yes or No. 

PIDs/LCD Set the number of PIDs to display on FlashScan V2 
LCD screen. 

Note 30 Automatically add “Note 30’ to log file when log file is 
paused/resumed using [OK]. Set to Yes or No. 

SD CRC Enable CRC data protection for SD card. 
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GM Fast Use EFILive's FAST CAN Mode for flashing.  This 
option can make flash speeds twice as fast on CAN 
controllers.  

CM BBF Set Cummins flash speed as Unlimited, Fast, or 
Standard. 

Skip Vfy Skip PID validation prior to starting BBL.  Set to Yes or 
No. 

Vfy BBR Perform extended verification of uploaded file.  Set to 
Yes or No. 

BBXStats Display OBDII retry statistics after Read/Flash is 
complete.  Set to Yes or No. 

BBX Dir Display folders when selecting tune files for flashing.  
Set to Yes or No. 

Switches Activates switchable tuning on simple menu.  Set to 
Yes or No. 

Trace Automatically save trace file for read/flash errors.  Set 
to Yes or No. 

BBXSpace Verify free space before logging data or reading a 
controller. 

LED Mode Set LED’s to illuminate to indicate operational status, 
indicate PID range alarms, or none. 

COM Port Set the device connected to serial port.  Supported 
devices are Wide Band O2, External, or Unknown. 

WO2 Type Select the type of Wide Band device connected to 
serial port*.  

WO2 Fmt Set the Wide Band controller configuration.  Bank 1, 
Bank 2, Both. 

WO2 Data Set the Wide Band data display format. 

WO2-1 ID Configure the ID's for multiple ECM AFR wide band 
controllers. 

WO2-2 ID Configure the ID's for multiple ECM AFR wide band 
controllers. 

Stoich Set the stoichiometric value for the fuel that is being 
used. 
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For Innovate’s wide band controllers, the stoich value 
can’t be set using this options, instead it must be set 
using Innovate’s Logworks software. 

Lo Power Set time frame to enable Low Power mode to 
conserve power when the device remains connected 
but unused for a set period of time. 

Splash Set splash screen display times. 

Alert Set Display Timeout Alerts in milliseconds. (0 = User 
must respond to message). 

Error Set Display Timeout Errors in milliseconds.  (0 = User 
must respond to message). 

AR Delay Set the time delay before a key begins to Auto-Repeat 
in milliseconds.  

AR Speed Sets the time delay between repeated key strokes in 
milliseconds. 

Inverse Choose screen color combination of White on Blue or 
Blue on White. 

Contrast Adjusts the contrast for FlashScan V2 with a blue 
case. 

Additional FlashScan V2 Device Settings are available in the follow menus 

F2 Set Date/Time 

Adjust date and time settings. 

F3 Change PIN 

Set passcode to prevent unauthorized use of FlashScan V2 when first powered 
on.  If there is no PIN set press [Enter] through the Enter Current PIN and press 
[Enter] message. 

[F4 Options] -> [F2 File System]  

F1 Delete Files 

Allows users to delete tune and scan files stored on FlashScan V2. 

F2 Free Space 

Displays the amount of used, free and bad space available on FlashScan V2. 

F3 Format File Sys  

Formats the data file system, deleting all scan and tune files stored on FlashScan 
V2. 

F4 File Sys Info 

Provides tools to view information about and explore the contents of the 
FlashScan V2 file system. 

  



EFILive V8 Reference 

support@efilive.com - 109 - www.efilive.com 

AutoCal V2 Configuration 

To edit the Device Settings directly on the AutoCal V2 Hold Next key to activate 
advanced menu while connecting AutoCal to your vehicle. 

Edit Settings 

Using the [Prev] and [Next] buttons, navigate to the [AutoCal Options] -> [Edit 
Settings] menu to manage the following options: 

Option Description 

Set Pro Menu Yes for Advanced Menu, No for Simple Menu. 

Set File # Set the sequence number for the next AutoCal 
generated file name.   

Set Locale Locale USA or Locale Non-USA. 

Set Units Metric or Custom. 

Set MRU PIDs Load Most Recently Used PID’s.  Set to Yes or No. 

Set Scan Rate Manage Logging Speed.  Set to Fast, Medium or Slow. 

Set CAN Baud V2 light-duty (blue/black) units have a fixed baud rate 
and cannot be changed. 
V2 heavy duty (red) units can be changed between 
default, 250K and 500K. 

Set Note 30 Automatically add “Note 30’ to log file when log file is 
paused/resumed using [OK]. Set to Yes or No. 

Set GM Fast Use EFILive's FAST CAN Mode for flashing.  This option 
can make flash speeds twice as fast on CAN controllers.  

Set CM BBF Set Cummins flash speed as Unlimited, Fast, or 
Standard. 

Set Skip Vfy Skip PID validation prior to starting BBL.  Set to Yes or 
No. 

Set Vfy BBR Perform extended verification of uploaded file.  Set to 
Yes or No. 

Set BBX Stats Display OBDII retry statistics after Read/Flash is 
complete.  Set to Yes or No. 

Set BBX Dir Display folders when selecting tune files for flashing.  
Set to Yes or No. 

Set Switches Activates switchable tuning on simple menu.  Set to Yes 
or No. 
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Set Trace Automatically save trace file for read/flash errors.  Set to 
Yes or No. 

Set COM Port Set the device connected to serial port.  Supported 
devices are Wide Band O2, External, or Unknown. 

Set WO2 Type Select the type of Wide Band device connected to serial 
port*.  

Set WO2 Fmt Set the Wide Band controller configuration.  Bank 1, 
Bank 2, Both. 

Set WO2 Data Set the Wide Band data display format. 

Set WO2-1 ID  Configure the ID's for multiple ECM AFR wide band 
controllers. 

Set WO2-2 ID Configure the ID's for multiple ECM AFR wide band 
controllers. 

Set Stoich  Set the stoichiometric value for the fuel that is being 
used. 

For Innovate’s wide band controllers, the stoich value 
can’t be set using this options, instead it must be set 
using Innovate’s Logworks software. 

Set Lo Power Set time frame to enable Low Power mode to conserve 
power when the device remains connected but unused 
for a set period of time. 

Set Splash Set splash screen display times. 

Set Alert Set Display Timeout Alerts in milliseconds. (0 = User 
must respond to message). 

Set Error Set Display Timeout Errors in milliseconds.  (0 = User 
must respond to message). 

Set AR Delay Set the time delay before a key begins to Auto-Repeat 
in milliseconds.  

Set AR Speed Sets the time delay between repeated key strokes in 
milliseconds. 

Use the [Prev] button to return to the top of the list and select [Exit] to return to 
[AutoCal Options Menu]. 

 

AutoCal V2 Device Settings contain serial wide band configuration 
options. AutoCal V2 does not ship with a serial port. A serial port can be 
fitted to the circuit board, but doing so will void Warranty. 

Additional AutoCal V2 Device Settings and information displays are available in 
the [AutoCal Options] menu: 
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Restore Settings 

Returns any modification made in the Edit Settings menu options back to factory 
defaults.   

Set Date and Time 

Adjust date and time settings. 

Browse Files 

View tune and log files stored on the AutoCal. 

Delete File 

Allows users to delete tune and scan files stored on the AutoCal V2. 

Free Space 

Displays used and available space on the AutoCal V2. 

Format File Sys 

Formats the data file system, deleting all scan and tune files stored on the 
AutoCal V2. 
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F7: Licenses 

Buttons 

Tune 

Next Tune Window (Alt+3) will make the Next Tune Window the focus window. 

New Tune Window (Ctrl+Alt+3) will open a New Tune Window. 

Tune Window will list the open Tune Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Scan 

Next Scan Window (Alt+2) will make the Next Scan Window the focus window. 

New Scan Window (Ctrl+Alt+2) will open a New Scan Window. 

Scan Window will list the open Scan Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Backup 

Backup will create a license backup file and save it to the My 
Documents\EFILive\V8\Backup folder, named XXXXXXXXXXXX.lbu.  

The XXXXXXXXXXXX portion of the backup filename will be replaced with the 
Serial Number of your FlashScan or AutoCal device. 

Refresh 

Refresh reloads license details from the attached device. 

Copy 

Copy will copy all details displayed to the clipboard. 

Close 

Close (Ctrl+F4) closes the Window.  
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Device Summary 

A summary for the connected device is displayed for FlashScan/AutoCal on the 
[F2: Hardware] tab.  The device summary details: 

1. Serial Number, License Number and Protected Number details. 
2. Model, Boot block and Firmware version details. 
3. Installed, Used and Available VIN Licenses.   
4. Flash Counters detailing the number of Cal Flashes and Full Flashes. 

Hardware Matrix 

Up to three serial number fields are displayed to identify the functionality of the 
connected device. 

Serial number displays the unique serial number of the connected device. 

License number links multiple FlashScan and/or AutoCal devices under one 
license.  This can be the same as the serial number for the attached device or the 
serial number of the Master FlashScan. 

Protected number is used for linking AutoCal and “Save For AutoCal’ operations.  
This can be the same as the serial number of the attached device or the serial 
number of the Master FlashScan. 

The combination of each serial number field determines the hardware capability 
for the connected device.  The following table displays the Hardware Matrix. 

Hardware Serial # License # Protected # Hardware Capability  

Master 
FlashScan 

Connected 
Device 

Connected 
Device 

Connected 
Device 

Has identical license and protected 
numbers to its serial number that are 
shared with zero, one or more Proxy 
/ Protected FlashScans. 

Proxy 
FlashScan 

Connected 
Device 

Master 
FlashScan 

Master 
FlashScan  

Has identical license and protected 
numbers that are shared with its 
Master FlashScan. 

Protected 
FlashScan 

Connected 
Device 

Connected 
Device 

Master 
FlashScan 

Has identical license and serial 
numbers that are not shared with 
any other device.  

Has a protected number that is the 
shared with its Master's (and its 
Master's Proxys’) license/protected 
number. 

Linked 
AutoCal 

Connected 
Device 

Master 
FlashScan 

n/a 
Serial and license do not match.  
License is set to the Master 
FlashScan. 

Unlinked 
AutoCal 

Connected 
Device 

Connected 
Device 

n/a 
Has identical license and serial 
numbers.  To be functional, the 
AutoCal must be linked. 

Tuning Licenses 

Each FlashScan device can be configured with a combination of different licenses: 
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1. Scanning and Logging which means the device operation is limited to scan 
tool duties and reading any EFILive supported controllers. It cannot be used 
to flash (i.e. re-program) any controllers. 

2. GM Tuning which means the device can flash any EFILive supported GM 
controller. 

3. Dodge Cummins Tuning which means the device can flash any EFILive 
supported Dodge Cummins controller. 

4. Cummins HD Tuning which means the device can flash any EFILive 
supported Cummins HD controller. 

5. Pro Tuning which activates advanced tuning options.  

The following table displays the Tuning Option matrix. 

Tuning 
Option 

FlashScan 
V3 

FlashScan 
V2 

FlashScan 
HD 

AutoCal 
V3 

AutoCal 
V2 

AutoCal 
HD 

Scanning 
and Logging       

GM Tuning       

Cummins 
Tuning       

Cummins HD 
Tuning       

Pro Tuning       

You can purchase Tuning Licenses from EFILive’s web site, just click the 
Purchase Activation Code(s) link in the software. You must provide your hardware 
serial number to purchase tuning options. 

Automated processing of your Tuning Option Activation code and included VIN 
licenses occur within approximately 10 minutes of order placement.  Validation of 
your serial ensures correct order placement.  The activation code must be entered 
into the correct field.  

VIN Licenses 

VIN Licenses for the attached device are displayed on the [F3: VINs] tab page. 
Each VIN license can be used to flash one engine controller.  Supported 
transmission controllers do not require a license. 

Lic # shows the license number for the connected hardware device. 

ECM (Only applicable for FlashScan/AutoCal V3 devices) shows the 
controller type to which the license has been. 

Engine Serial shows the last 9 letters/digits of the engine controller serial 
number to which the license has been allocated. 

Engine VIN (Only applicable for FlashScan/AutoCal V3 devices) shows 
the VIN of the engine controller to which the license has been allocated. 

You can purchase additional VIN licenses from EFILive’s web site, just click the 
Purchase Activation Code(s) link in the software. To order, you must provide; 

http://www.efilive.com/licenses/tuningoptions-1
http://www.efilive.com/redirect_vinlic.html
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1. Hardware serial number. Click the [Copy] button on the [F2: Hardware] tab 
page to copy the serial number to the Windows Clipboard. 

2. Auth code. Click the [Copy] button on the [F3: VINs] tab page to copy the 
Auth code to the Windows Clipboard. 

Automated license processing occurs within approximately 10 minutes. Validation 
of your serial and auth code ensures correct order placement.  

The activation code must be entered into the Activation Code field and the License 
Number must be set to the number of licenses the device will contain after the new 
VIN license are added. For example if the device currently contained 10 VIN 
licenses and you purchase 3 more, then select 13 as the License Number. 

If you do not receive an email response from the automated VIN license web 
page, please log into the EFILive store and view the notes attached to your order. 
Refer to the Order Status, Order History & Historical Activation Codes for 
assistance in locating order history. 

Stream Licenses 

Stream licenses are available on FlashScan V2 for some controller types. Stream 
licenses allow for unlimited tuning of various controller types. 

Stream Licenses for the attached device are displayed on the [F4: Streams] tab 
page. Each Stream license can be used to flash unlimited numbers of controllers 
of that type. 

Code shows the stream code as shown on the EFILive web store and the 
status of the stream license. A grey cross indicates that the steam is not active 
on the device. A green tick indicates that the stream is active on the device. 

Description is a description of the stream. 

Installed shows stream licenses that have been activated for the connected 
device. 

Available for Purchase shows stream licenses that can be purchased. 

You can purchase additional Stream licenses from EFILive’s web site, just click 
the Purchase Activation Code(s) link in the software. You must provide your 
hardware serial number to purchase Stream licenses. 

Stream licenses are delivered via email during regular New Zealand business 
hours. The activation code must be entered into the Activation Code field and the 
correct Stream must be selected from the drop down list box. 

If you wish to claim your VIN license rebates when purchasing Streams, please 
contact sales@efilive.com prior to placing an order. 

Convert 

The conversion option allows end users to enter a code generated by the tuner 
remotely to perform the following actions: 

1. Link an AutoCal device to a FlashScan device. 
2. Unlink an AutoCal device from a FlashScan device. 
3. Change the maximum number of VIN slots available for a linked AutoCal 

device. 

https://service.efilive.com/kb/articles/order-status-order-history-historical-activation-codes
http://www.efilive.com/redirect_stream.html
mailto:sales@efilive.com
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To perform any of those actions, the tuner who owns/controls the FlashScan 
device to which your AutoCal device is linked (or is to be linked) must provide you 
with the appropriate Conversion Code. 

Copy/paste the Conversion Code and click the [Convert] button. 
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F8: Tools 

Buttons 

Tune 

Next Tune Window (Alt+3) will make the Next Tune Window the focus window. 

New Tune Window (Ctrl+Alt+3) will open a New Tune Window. 

Tune Window will list the open Tune Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Scan 

Next Scan Window (Alt+2) will make the Next Scan Window the focus window. 

New Scan Window (Ctrl+Alt+2) will open a New Scan Window. 

Scan Window will list the open Scan Windows. 

OBD Window (Alt+4) will open the OBD Window. 

BBX Window (Alt+5) will open the BBX Window. 

Devices Window (Alt+6) will open the Devices Window. 

Licenses Window (Alt+7) will open the Licenses Window. 

Tools Window (Alt+8) will open the Tools Window. 

Close 

Close (Ctrl+F4) closes the Window.  

Search 

Search 

Historically to find a particular scan or tune file, the user would have to open a 
range of files to view controller information.  This feature allows users to search 
EFILive files for specific controller information without the need to open each file. 

Users can define the following: 

Search Folder Set the folders on your PC to be included in the search. 

Controller Info Set one or more of the following search criteria: 

1. VIN 
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2. Controller Serial 
3. Remote AutoCal License 
4. Operating System (or Any Segment Part #) 
5. Checksum (must select Search Entire File for this field to be active) 
6. User Comments 
7. Controller ID 

File Types Set one or more file types to be searched. 

1. V8 Tune Files 
2. V8 Quick Setup Files 
3. V7 Tune Files 
4. Binary Files 
5. Scan Files 

Search Options Set the search type to search Meta Data Only or Search 
Entire File. 

Search Now commences the search.  Once Search Now is selected, the 
search can be stopped by pressing Stop.  Stop will retain all EFILive files 
returned in the search up until that point. 

Clear removes controller info selections.  Search Folder does not clear/revert 
to previous selection. 

Data returned from a search can be used in a variety of ways;  

1. Left click on the chosen column heading to sort by alpha/numeric values 
contained in that column.  

2. Double click on a file will open that file within V8 Scan and Tune software. 
3. Right click over a file will give options to: 

1. Open File. 
2. Open File Location.  

4. Single click on a file will highlight that file, activating the arrow keys to move 
up/down the list, and displays the file location path in the display footer. 

Browse 

The browse function allows users to navigate through folders on the PC and 
display specific controller information for EFILive files without the need to open 
each file.  Short cuts to common EFILive file storage locations, and windows 
explorer style navigation system are provided. 

Users can specify to Show Part Numbers from Meta Data or Extract Part Numbers 
from File.   

Extracting Part Numbers from File option can be slow, and displays segment 
details (Part Numbers) contained in the tune file that may not be contained in Meta 
Data.   

Browse files displayed can be used in a variety of ways; 

1. Right click on the column heading provides column display selection options. 
2. Left click on the chosen column heading to sort by alpha/numeric values in 

that column. 
3. Double click on a file will open that file in the application the file is associated 

with. 
4. Right click over a file will display standard windows explorer right click 

options.   
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5. Single click on a file will highlight that file, activating the arrow keys to move 
up/down the list. 

Importing Data 

This section is not written yet. 

Exporting Data 

This option is not yet available. 

Controller Lock/Key Management 

Whenever you choose to lock a controller, a copy of the seed and key that you 
used to lock the controller is saved in a file called PCMLocks.ini (V7), or in 
FlashScan's or AutoCal's onboard flash memory (V8).  Locks that are created 
automatically when flashing Auto-Lock files using the V8 software are not available 
via this utility. 

The key recovery utility will search for a key that matches either the controller's 
serial number or controller's seed value that you enter. It will search in the 
following locations: 

1. In the file called PCMLocks.ini on your computer, as saved by the V7 
software. 

2. In the flash memory of the connected FlashScan or AutoCal device, as saved 
by the V8 software. 

To begin searching, enter the controller's Serial Number (12 letters/digits) or the 
controller's Seed value (a decimal number between 0 and 65,535 or a 
hexadecimal number between $0000 and $FFFF) then click the [Find Key] button. 

Note: Multiple matching keys may be displayed. You should try all matching keys 
when attempting to unlock a controller. To lock or unlock a controller, use the [F3: 
Tune]->[F2: Read]->[Lock/Unlock] option. 

Bulk Files 

Update Files 

From time to time EFILive's proprietary encryption routines are updated.  To check 
for updated encryption and/or apply encryption changes to tune files, users can 
check and/or automatically update folders of *.ctz and *.coz tune files without the 
need to open and re-save individual tunes.  Tune files can be checked/updated via 
a batch process. 

 

EFILive recommends user’s backup all tune files to a second location 
before Updating Tune Files.   The Update Tune Files option edits 
existing tune files.  This option does not duplicate or backup tune files.  

Folder navigation is used to locate files to be checked/updated. 

Include subfolders option allows subfolders of the chosen folder to be 
checked/updated. 

Test Only option will check each tune file located in the chosen folder(s) and 
display files to be updated.  This option does not update tune files, but will display 
a list of tune files that needs updating. 

Update button will process files in the selected folder(s) that need updating. 
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Where Test only is selected, a TEST MODE ONLY list will display files that require 
processing. 

Where Test only is not selected, Update Now will update outdated *coz and *tune 
files to the latest version. 

An error list is also provided should files fail to be updated. 

Convert Files 

EFILive can generate *.coz copies of *.ctz files via a batch process without the 
need to open and select save-as to convert individual tunes.  The original *.ctz 
tune file remains untouched. 

Folder navigation is used to locate files to be copied. 

Include subfolders option allows subfolders of the chosen folder to be copied. 

Test Only option will check each tune file located in the chosen folder(s) and 
display files that can be converted.  This option does not convert tune files, but will 
display a list of tune files that can be converted. 

Overwrite existing *.coz files will overwrite and replace the contents of an 
existing *.coz file if a *.ctz file with the same name exists during the copy process. 

Convert button will process files in the selected folder(s) that can be copied from 
*.ctz to *.coz. 

Where Test only is selected, a TEST MODE ONLY list will display files that can be 
converted. 

Where Test only is not selected, Convert will convert *.ctz to *.coz and *tune files, 
leaving the original *.ctz tune file untouched. 

An error list is also provided should files fail to be updated. (i.e. some controllers, 
including Cummins do not support *.coz files) 

Collate Files 

EFILive can collate scan and tune files based on file templates.  Users can copy or 
move files based on various data such as VIN, OS and ECM type.  A full list of 
available criteria is available by accessing the destination folder/file name option 
and right clicking in the Folder or File template field. 

Convert User Calibration Files 

EFILive can copy and convert V7 *.cax files stored in the C:\Program Files 
(x86)\EFILive\V7.5\Calibrations directory to V8 *.cax8 file format and place them in 
in the C:\Users\Documents\EFILive\V8\User Defined Cax8 directory. 

Specify a Provider Name which will be displayed on the Provider tab on each 
calibration defined within the *.cax8 file.    

Use the Unique ID to identify your custom calibration name in the navigation tree 
and parameter heading to prevent calibration name conflicts between multiple third 
parties.  

It is highly recommended to backup any existing *.cax8 files before attempting to 
convert.  Existing *.cax8 files may be overwritten without asking. 
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Convert Script Files 

EFILive can copy and convert V7 metric script files stored in the 
C:\Users\Documents\EFILive\V7.5\User Configuration\Scripts directory to V8 LUA 
script files in the C:\Users\Documents\EFILive\V8\Scripts directory. 

It is highly recommended to backup any existing V8 LUA script files before 
attempting to convert.  Existing *.lua files may be overwritten without asking. 

 

Script conversion assumes that all numeric values in the V7 script are 
in metric units. If any units are non-metric they will be incorrectly 
processed as if they were metric by the V8 software when the script 
is run. 
If non-metric units are used in your V7 script files, then after you have 
converted the V7 script file to a V8 script file you must edit the script 
file and change all non-metric values in the V8 script file to their 
metric equivalent, including data tables. 

The EFILive V8 conversion tab page may be used to help with the conversion 
process.  

For example to convert single values like 12.34psi to kPa, you can use the top part 
of the [Conversion] tab page, like this: 

 

To convert an entire data table in a V8 script from psi to kPa: 

1. Copy the entire table from the script to the clipboard. 
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2. Click the [Create New Table]. 

 

3. Select From: psi and To: kPa, then click the [Convert Table] to convert the 
entire table from psi to kPa. 
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4. Highlight the entire table (by clicking in the top left gray cell)  and right-click 
and select "Copy as Lua Source". 

5. Paste it back into the script, overwriting the previous data. The table will be 
pasted with the generic name TableName, you must change TableName to 
the original table's name. 

6. Note: after pasting the new metric data table and renaming it to the correct 
name, remember to delete the original non-metric data table with that same 
name from the script table. 

Bin Mapping 

EFILive tune files are usually stored in encrypted *.ctz files. However, *.bin (binary 
format) and/or *.hex (Motorola hex record format) files may also be opened by the 
EFILive software. 

The *.hex file format will always contain a 1-to-1 mapping of the controller’s 
memory and the data in the *.hex file. 

To save file space, the *.bin file format as implemented by EFILive, will not always 
contain a 1-to-1 mapping of the controller’s memory and the data in the *.bin file – 
depending on the controller type. 

When creating *.cax8 files for controllers with address mapping, ALWAYS use the 
controller's address as shown by this tool, not the *.bin file address (unless the 
addresses are the same). 

Use this tool to display the address mapping for each controller type and to 
accurately convert between the *.bin file addresses and the controller's memory 
addresses. 

Lookup Error Codes 

A large range of EFILive error codes are documented to assist with trouble 
shooting.  Enter the 4 digit error code displayed in V8 Scan and Tune software, or 
displayed on FlashScan/AutoCal LCD screen with or without the $ prefix and 
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select enter.  The error code description, the cause and possible actions will be 
displayed. 

The EFILive Error Messages.PDF document can be displayed by selecting the 
message at the bottom of the screen, or by navigating to Start->All Programs-
>EFILive->V8->Documents->EFILive Error Codes. 
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Properties 

General 

Display 

The main EFILive window displays the most recently used tuning files and the 
most recently used scan files. You can select which columns of data you would 
prefer to be visible by checking the appropriate recent start check boxes. The 
columns can also be selected by right clicking on the list of files in the main 
EFILive window and selecting “Select Columns”. 

Many sub-windows display a set of tab options down the left hand side of the 
window and a set of buttons across the bottom of the window. Those controls take 
up some screen real-estate. To allow the window more screen real-estate, you 
may choose to make the tabs and buttons smaller. The tab and button sizes can 
also be controlled using the menu option View->Hide Tab Descriptions and View-
>Small Buttons. 

Controllers displayed in EFILive software are grouped by controller type and by 
default are displayed in an EFILive defined sort order.  You can choose to display 
controllers by each group in alphabetical order. 

A range of useful software tips are displayed at software startup.  These can be 
disabled or reactivated in the Display menu.  Tip of the day can also be displayed 
using the menu option View->Tip of the Day, and disabled using the check box on 
the Tip of the Day screen. 

Three color themes are available; Windows (Light), Slate (Medium) and Onyx 
(Dark).  To apply theme changes, make a selection and restart the application. 

Locale 

Because the EFILive software is used in many countries around the world it must 
be able to handle data transfers using different numeric and date formats. The 
Quick Select options selects the chosen measurements default settings.  The 
three options for formatting numbers and dates can also be manually selected: 

1. Display: these settings control the format of numbers and dates that are 
displayed on this computer’s screen. 

2. Clipboard: these settings control the format of numbers and dates that are 
copied to and pasted from the clipboard. 

3. Import/Export: these settings control the format of numbers and dates that 
are exported from and imported to the software.  If for example you are 
based in the US and you attempt to send an exported file to a colleague in 
Europe then you could select the Euro number and date formats to allow 
your exported data to be imported seamlessly by your European colleague. 
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Files/Folders 

When saving tune files you can choose which file types you want to be displayed 
in the save file dialog box. 

Auto-Generate and Auto-Increment filenames will (by default) append a unique, 
incrementing number to the end of scan and tune file names each time you select 
“Save As”.  Users can setup Auto-Generate and Auto-Increment when using both 
“Save” and “Save As” options, as well as increment *.coz files. 

The Tune Templates… and Scan Templates… options allows you to specify the 
layout and content of the auto-generated filename and the size and position of the 
auto-incrementing number within the filename, see next section. 

When saving tune files for use with a remote AutoCal device, you can choose 
which other security settings you want to be automatically applied to the saved file. 

 

When saving files for use with AutoCal devices, the unique ID may not 
be visible on AutoCal's display because only the first 8 characters of the 
filename are shown. 

Files/Folders – Tune Templates… and Scan Templates… 

Templates can be created that determine the folder and file names which will be 
used when newly created scan and/or tune files are being saved. Templates 
contain tags which are identified by angle brackets such as: <ctrl> and <type>. 
Each tag in the template is replaced with its appropriate value when creating the 
folder and file names.  

File/Folder template selections are accessible by right mouse click in the Folder 
Template and the File Template text boxes.  Templates can be restored to default 
settings by selecting Restore [<-] option. 

Tag Replaced with 

<mydoc> C:\Users\username\Documents\ 

The <mydoc> tag should only be applied to the folder template. 

<filename> The file’s original name.  Can only be applied in the File 
Template. 

<type> Scan if saving a *.pld log file or 
Tune if saving a *.ctz tune file. 

The <type> tag may be applied to the folder and file templates. 

<ctrl> The controller name of the file being saved, such as E38, T43 
or LS1B. 

The <ctrl> tag may be applied to the folder and file templates. 

<os> The operating system number identified in the file. 

<sn> The serial number of the controller identified in the file. 
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<vin> The VIN of the vehicle identified in the file. 

<cn> Customer Name if defined in the Scan Tool -> Config -> 
Manage Customers and Vehicles register.  If customer name is 
not defined, then <cn> will default to “Customer Name”. 

<reg> Vehicle Registration if defined in the Scan Tool -> Config -> 
Manage Customers and Vehicles register.  If vehicle 
registration is not defined, then <reg> will default to “ABC-123”. 

<name> Vehicle Name if defined in the Scan Tool -> Config -> Manage 
Customers and Vehicles register.  If vehicle name is not 
defined, then <name> will default to “Vehicle Name”. 

<date> The current date in the form CCYYMMDD. 
Nov 16, 2015 would be 20151116. 

The <date> tag should only be applied to the file template. 

<cc> The current century i.e. 19, 20, 21 etc. 

While it is technically true that the 20th century covers the years 
ranging from 1901 to 2000, for ease of use this tag always 
returns the first two digits of the current 4 digit year, regardless 
of the definition of a “century”. 

The <cc> tag should only be applied to the file template. 

<yy> The current year in the range 00..99. 

The <yy> tag should only be applied to the file template. 

<mm> The current month in the range 01..12. 

The <mm> tag should only be applied to the file template. 

<dd> The current day in the range 01..31. 

The <dd> tag should only be applied to the file template. 

<jd> The current Julian day in the range 01..366 
Nov 16, 2015 would be 319. 
The <jd> tag should only be applied to the file template. 

<time> The current time in the form HHNNSS. 
6:15:30p.m. would be 181530. 

The <time> tag should only be applied to the file template. 

<hh> The current hour in the range 00..23. 

The <hh> tag should only be applied to the file template. 
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<nn> The current minute in the range 00..59. 

The <nn> tag should only be applied to the file template. 

<ss> The current second in the range 00..59. 

The <ss> tag should only be applied to the file template. 

The <vin> and <filename> tags can be subdivided into sub-sections by adding 
start and length modifiers to the tag: <tag:start:length>. A negative start number 
will count backwards from the end of the text. 

Examples: 

1. <vin:1:3> will return the first 3 characters of the VIN. 
2. <vin:-6:6> will return the last 6 characters of the VIN. 
3. <filename:5:4> will return character 5..8 of the filename. 

Auto-Generate and Auto-Increment file names can use a variety of sequence 
setups to best suit your needs.  

1. Digits determines how many digits will be inserted into the file name to 
represent the sequence number. Set digits to 0 to use the smallest number 
of digits required to represent the sequence number. I.e. instead of _0015, 
_15 would be used instead. 

2. Delimiter Character determines how the software identifies the sequence 
number in the file name. I.e. whether the sequence number is surrounded 
by spaces or by underscores. 

3. Position In File Name determines where the sequence number is placed in 
the filename. 

Prefix means a 1 to 4 digit number will be prepended to the file name 
followed by the chosen delimiter character. Or if an existing 1 to 4 digit 
number already exists at the start of the file name then that number will be 
used as the sequence number. 

“Prefix” Examples (delimiter is underscore) 

1234_E38 Z06 16 Race Tune.ctz 

55_LS1B.ctz 

Suffix means a 1 to 4 digit number will be appended to the file name 
preceded by the chosen delimiter character. Or if an existing 1 to 4 digit 
number already exists at the end of the file name then that number will be 
used as the sequence number. 
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“Suffix” Examples (delimiter is underscore) 

E38 Z06 16 Race Tune_1234.ctz 

LS1B_55.ctz 

First means the first 1 to 4 digit number that has the chosen delimiter 
characters immediately before and after, will be used as the sequence 
number. 

“First” Examples (delimiter is space) 

E38 12 Z06 16 Race Tune.ctz 

Notice how the 12 (not the 16) is identified as the first 
sequence number. 

LS1B 55 Track.ctz 

Last means the last 1 to 4 digit number that has the chosen delimiter 
characters immediately before and after, will be used as the sequence 
number. 

“Last” Examples (delimiter is space) 

E38 12 Z06 16 Race Tune.ctz 

Notice how the 16 (not the 12) is identified as the last 
sequence number. 

LS1B 55 Track.ctz 

4. Restore [<-] will restore Auto-Increment settings to defaults. 

If the Update sequence number dynamically option is checked, then when the 
“Save File” dialog box is displayed, each time the user selects a new folder, that 
folder is scanned for matching filenames and the sequence number is updated to 
reflect the next available sequence in that folder. 

If the Include the letters A..Z in sequence numbers option is checked, then the 
sequence numbers will user the digits 0..9 and the letters A..Z before wrapping 
around to 0 again. 

 

Be aware that when using letters as part of the sequence number, the 
software can be easily confused by filenames such as MY_TUNE.ctz. 
In that case the _TUNE part of the filename is effectively the sequence 
number, the next few values in the sequence would be _TUNF, _TUNG, 
_TUNH etc. 

If the Auto-Generate and Auto-Increment filenames option is active then… 
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When saving a file that has been created by EFILive, i.e. a tune file that has 
been read from a controller or a log file that has been recorded from a 
controller, the file being saved is considered a new file. 

When a new file is being saved, the folder template is used to determine 
where is should be created and the file template is used to determine the 
filename. The sequence number will be incremented and inserted into the 
filename (if possible) to ensure that the filename is unique in the folder in 
which it is being saved. 

 

The value of the sequence number is determined by scanning the entire 
folder for all conflicting filenames, finding the highest numbered 
conflicting filename, then adding one to that file’s sequence number. 
For example: 
if a file being saved is E38.ctz and 
its new sequence number filename is E38_nnnn.ctz and 
if the target folder contained the file E38_1234.ctz then 
the new filename would be E38_1235.ctz. 

 

If a file name with the highest possible sequence number already exists 
in the target folder, then the new file name will use that same sequence 
number. 

If the Default to template folder (create folder if it does not exist) option is 
checked, and the folder path does not exist it will be created. 

When the Default to most recently used folder is checked, the most recently 
used path will be used. 

An existing file is always saved back into the folder from which it was opened 
using the same file name but with the incrementing sequence counter 
embedded in the name. 

If the Auto-Generate and Auto-Increment filenames option is disabled then… 

When saving a new file the default Scan or Tune folder will be used. 

When saving an existing file the file is saved back to the folder from which it 
was opened, using the same file name. 

Printing 

Not available yet. 

Settings 

When Opening the “F6: Devices” window: 

Use these options to determine how the software will initialize the information 
displayed in the “F6: Devices” window. 

Load settings from: 

Check the most recently used file option to cause the most recently opened 
or saved device (*.dat) file to be re-opened. This option is useful for EFILive 
dealers when setting up multiple AutoCal devices. 

Check the connected device option to cause the software to attempt to read 
the device settings from the currently connected device. This option is useful 
for tuners who are using the same device most of the time. 
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If no device is connected then the software needs to know which device specific 
options to enable. Select the option that bests suits your needs. 

Units 

The EFILive software is extremely flexible when it comes to displaying data in your 
preferred units. By default the EFILive software uses metric units to store and 
display data values. However, many customers are more familiar with and prefer 
to work with US customary units. The Units settings allow you to define any units 
in which to display your data. 

There are three tab pages in the Units section: 

1. Units: This is where you define the units of your choice. 
2. Conversions: This is where you tell the EFILive software how to convert 

from the underlying metric value to the units of your choice. 
3. Default Units: This is where you define the default units that you want to 

use for various types of measurements. 

To define a unit, for example “Knots” which measures speed: 

• Select the Units tab page and click on the green plus button (Ctrl+Ins). 

• Type the name of the units: Knots, then press Tab. 

• Select the group: Speed, then press Tab.  
Note: The group name is important because it determines which units are 
offered by the software, when displaying values that deal with speed. 

• Enter the description for multiple units, i.e. Knots, then press Tab. 

• Enter the description for single units i.e. Knot, then press Tab. 

• Enter the most likely minimum value for this unit, i.e. 0, then press Tab. 

• Enter the most likely maximum value for this unit, i.e. 50, then press Tab. 

• Enter the precision (the number of decimal places to display), i.e. 0. 

To define the conversion from km/h to Knots: 

• Select the Conversions tab page and click on the green plus button 
(Ctrl+Ins). 

• From the drop down list in the first column, select km/h->Knots, then press 
Tab. 

• Enter the multiplication factor that you should multiply 1 km/h by to get 1 
Knot, i.e. 0.54, then press Tab. 

• Enter the value to add to the above multiplication if required. In this case no 
additional offset is required, so enter 0, then press Tab. 

• If the conversion requires that the metric value should be inverted prior to 
multiplying by the factor, then check the “Invert” check box. In this case 
inversion is not required, so leave the check box unchecked. 

You can test the conversion by sliding the “Test” slider left/right. The values of the 
metric and converted units are displayed. 

You may have noticed that when you create or modify units the icon to the left of 
the unit name shows differently. To see a description for each icon, right click on 
any unit and select “Show Legend”. 

A user modified entry can be restored to its system default by right clicking on it 
and selecting “Restore” (Ctrl+R). 

The Default Units tab page is where you decide which units you want to use for 
various measurement. You can set up three different sets of default units: Metric 
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(used mostly in Europe and Asia), US Customary (used mostly in the USA) and 
User Defined. 

• The Metric column should contain only metric units. 

• The Custom column should contain only US customary units. 

• The User Defined column may contain a combination of metric and US 
customary units. 

 

You can use the default units to quickly select the units for multiple 
PIDs. For example in the [F2: Scan Tool]->[F3: Data] tab page, highlight 
one or more PIDs that have the same unit group, then right click and 
select the desired default units. 

User Info 

Record your user information here. The text that you enter into the Author field can 
be optionally copied into tune files that you create. Select one or both of the check 
boxes to cause the text to be copied into tune files when they are being saved. 

If you check the “Created By” check box, then when you first save a tune file after 
reading it from a controller, the text will be copied into the file’s “Created By” field. 
Once the “Created By” field is populated in the tune file it cannot be changed. 

If you check the “Modified By” check box, then each time the file is saved, the text 
will be copied into the file’s “Modified By” field. The modified field will be 
overwritten each time the file is saved. 

The other fields; Name, Company and Email are used as default settings for 
sending receiving data log files, tune files and support files between a customer 
and a their tuner or EFILive. (The email subsystem is not operational in the 
EFILive software yet). 

Warnings 

Disable/Enable various warning messages that are displayed by the EFILive 
software. 

Scan Tool 

Dashboard 

Show PIDs’ Controller Names causes PIDs to be listed in drop down selection 
lists prefixed with their controller names. This option is useful to help distinguish 
between PIDs with identical names from different controllers. For example 
ECM.RPM and TCM.RPM, without the controller prefix both PIDs would display 
RPM only. 

Show PIDs’ Descriptions causes PIDs to be listed in drop down selection lists 
along with their description. This option is useful to help you identify PIDs as 
sometimes it is difficult to identify them by their name only. 

Sort PIDs Alphabetically causes PIDs to be listed in drop down selection lists 
sorted alphabetically. Otherwise the PIDs are listed in the order that they are 
displayed in the PID selection list. 

Expand PID Selection Groups Automatically causes all groups in the list of 
available PIDs to be automatically expanded. 



EFILive V8 Reference 

support@efilive.com - 133 - www.efilive.com 

Ask to Save PID Changes will prompt you to save any changes that you make to 
the PID selection. 

Automatically Save PID Changes will automatically save any changes that you 
make to the PID selection without asking. 

Automatically Discard PID Changes will automatically discard any changes that 
you make to the PID selection without asking. 

Maximum PID Selection Menu Items will split PID selection menus if more than 
this many items are selected. 

Hardware Acceleration will force the EFILive software to use OpenGL hardware 
acceleration if it is available on your system. You can check the OpenGL hardware 
capabilities by clicking on the [About] button in the main EFILive window. 

 

If your system does not have hardware acceleration, it may attempt to 
support OpenGL using software emulation. In that case, using OpenGL 
with the EFILive software will be slower than not using OpenGL. 

Use Simple Data Plot will plot data in the charts using a less accurate but faster 
drawing algorithm to display compressed chart data. Use this option if you have a 
slow PC.  

The drawing is only less accurate when the zoom level displays more data frames 
on the screen than there are horizontal pixels in the charts. Once the zoom level 
can display each frame of data in one or more pixels then this option has no effect. 

Show Descriptions As Caption Hints will display PID descriptions as pop-up 
hints when you hold the mouse over a PID caption in the charts. 

Show Button Hints determines if the hints on the “Hide/show PID” and “Auto 
Scale” buttons in the charts’ y-axis are displayed or not. 

Dynamic Resize Limit will prevent charts being redrawn while the scan window is 
being resized if the number of frames in the log file is greater than this value. Log 
files with 50,000 frames or more may take a non-trivial amount of time to redraw. 
Performing that redrawing while trying to resize the window is counterproductive. 

Progress Bar Delay will cause a progress bar to display if the chart redrawing will 
take longer than this many milliseconds. 

Allow Secure DVT Controls send security password to controller when activating 
DVT controls. 

Data Logging 

Maximum Log File Size determines how many frames of data can be logged 
before the log automatically stops. 

Use the Estimated Time and Size Limits options to determine the optimum number 
of frames to reserve for data logging. 

Automatically Save Log File check this option to have log file saved 
automatically when logging stops. 

Prompt for Filename ask user to provide filename otherwise use templates. 

Clear Data After Auto-Saving check this option to clear logged data after auto-
saving, ready for next data log. 

Save DTCs when checked, DTCs will be scanned at the end of the data log and if 
any DTCs are detected they will be stored in the log file. DTCs that are stored in 
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the log file in this way can be viewed using the [Config]->Display/Change Log File 
Information (Ctrl+I) option in the Scan Tool window. 

Export Options when checked exports PID descriptions when exporting logged 
data and export text values for state encoded data.   

Playback 

Arrow Key Scrolls sets the number of frames that the Left and Right arrow keys 
will move the chart inspector. 

Ctrl+Arrow Key Scrolls sets the number of frames that the Ctrl+Left and 
Ctrl+Right arrow keys will move the chart inspector. 

If the charts are scaled such that each display pixel represents more than one 
frame, then these values will be interpreted as the number of pixels (not frames) to 
move the chart inspector. 

Tuning Tool 

Editor 

Default Units selected here are displayed when a calibration is opened for the 
first time.  If the calibration’s units and/or precision are changed while it is 
displayed in the editor those changes are saved and used next time the calibration 
is opened overriding the default setting.   

Revert to Default units will reset any custom calibration units and/or precision 
adjustments back to default.  Calibration that are currently open in the editor will 
not be reset. 

Show Modified Axis will show modification to calibrations displayed in the 
navigational tree when a related axis is modified. 

Allow Cax8 in OS Memory allow definitions that are defined in the OS area of a 
tune file.  This option is only available for LS1A, LS1B, P10, P11, P12, L31, P08, 
T42, T43, T76, AL5, A40 and A50 controllers only. 

Table set the view of tables’ main title bar, adjust entire window to display cells 
and cell font sizes. 

Sync With Window Size displays all cells in the  

2D Chart set options when dragging points using the mouse. Also set line width, 
point width, point height, point visibility and show label points of Y-Axis. 

3D Surface set options for grid lines, cube display and axis labels. Set default, 
classic or custom colors. 

Colors use Default V8 color selection, Classic colors modelled on V7 colors, or 
set Custom colors. 

Scripting 

Set scripting defaults for tables and cells for numeric tables and enumerated 
tables. 

VE Tables 

Set display units for Non Virtual VE Tables.  Changes are displayed in real-time, 
no need to close/re-open the tune file when changing units. 
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Charge pressure is used when converting VE calibrations that do not contain a 
pressure axis.   

 

Undo/redo information is discarded for all open VE tables if/when the 
VE display units are changed, which means changes to VE tables 
cannot be undone/redone after changing the VE display units. 

Virtual Torque 

Use the Air Per Cylinder section to create the axis labels for the horizontal axis of 
the APC virtual torque tables. 

Use the Manifold Absolute Pressure section to create the axis labels for the 
horizontal axis of the MAP virtual torque tables. 

Use the Spark Advance section to create the list of spark advance degrees for the 
virtual tables. 

Note: all axis label values are subject to range limitations, a warning will be 
displayed if any labels are out of range. Hover the mouse over the warning 
message to display the range limits. Any label ranges that contain "out of range" 
values will not be used, instead the virtual torque tables will be displayed using 
default axis labels. 

 

Changing these axis definitions for the virtual torque tables will only 
affect newly displayed virtual torque tables.  Torque tables that are 
currently displayed in the editor will not be adjusted until they are 
closed and reopened.  

Read/Flash 

Seed/Key Security will select default settings for reading and flashing options in 
the Tune tool.  These options are not used for BBX.  

High Speed (VPW Only) will enable the use the high speed VPW mode to 
transfer data from the controller. High speed VPW is 4 times faster than standard 
VPW. 

Cummins Fast CAN Mode (for CMD, CME, CMF controllers only)  

Unlimited Fast CAN delivers the fastest possible flash time and is approx. 
50% faster than standard flash routines.   

Fast CAN is a little faster than standard, but more robust than Unlimited.  

If you experience flash failures when using Unlimited Fast Can or Fast CAN, 
try unchecking that option and retry the flash. 

Show Summary When Finished will automatically display the [F3: Calibration] 
tab page when reading is complete. 

Perform Test Flash Only will simulate the flash process, complete with full data 
transfer to/from the controller. This option is not supported on all controllers. 

Display lock/unlock key entry fields with a password mask will hide 
passwords when entered, which is useful for entering a private key during a 
remote tuning session.  Passwords can be displayed by unchecking this box. 
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EFILive V8 Control Panel 

 

The EFILive V8 Control Panel is a utility that manages FlashScan and AutoCal 
hardware and associated connections.   

The EFILive V8 Control Panel is started automatically whenever an EFILive V8 
application attempts to communicate with either a FlashScan or an AutoCal 
device. It is terminated automatically when all EFILive applications are closed. 

The Control Panel can be opened via the [EFILive Control Panel] button at the top 
right of the EFILive V8 Scan and Tune main window, or by clicking on the 
FlashScan icon in the Windows System Tray (on the Windows Task Bar near the 
clock) while EFILive V8 Scan and Tune software is running. 

The Control Panel may also be started independently of any other EFILive 
application by selecting the “EFILive V8 Control Panel” option from the Windows 
Start Menu. If you manually start the Control Panel from the Windows Start Menu, 
then you will need to manually close it by right clicking on the FlashScan icon in 
the System Tray and selecting “Exit”. 

USB Connections  

Displays the license details of FlashScan and/or AutoCal, and displays the 
connection status of: 

• USB. 

• FlashScan and/or AutoCal. 

• Vehicle/Controller. 

The “Sent:” and “Recv:” counters display the number of messages sent and 
received via the USB connection to all devices. 

[Reset] resets counters to zero. 

[Devices] checks the connection status. 

USB Testing 

To test the USB connection, select FlashScan or AutoCal and click [Test] for the 
connected device. 

The USB connection is tested 10 times, unless the extended option is enabled.  
When the extended option is enabled, the USB connection test is performed 100 
times. 

The test results are displayed in the “Result:” field. If the test passed then “OK” is 
displayed, otherwise an error message is displayed to indicate why the test failed. 

You should expect to see approximately 1.0 to 1.2Mbps (million bits per second) 
transfer speed. 
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Options 

Allows users to configure the EFILive V8 Control Panel for a range of options 
including; 

Popup Balloons 

Show information balloon at startup.  Enable/disable the information balloon 
that is displayed when the EFILive Control Panel is first started. 

Prompt for firmware upgrade when available.  Automatically displays a balloon 
with the prompt: “The FlashScan or AutoCal firmware requires updating” when a 
firmware update is detected and available. 

Automatic Refresh 

Automatically refresh the USB connection status when the [F2: USB] window 
is opened. 

Automatically refresh firmware details when the [F6: Firmware] window is 
opened. 

Automatically refresh FlashScan’s/AutoCal’s internal clock with the time from 
the PC’s clock when the Control Panel first connects to the device. The internal 
clock is not updated until 5 seconds has elapsed and there is no other 
communication between the device and the Control Panel. To manually update the 
internal clock use the [F10: Date/Time] tab page in the EFILive Explorer 
application. 

[Restore] restores changes to the installation defaults. 

[Cancel] cancels any changes made to the configuration. 

[Apply] saves changes made to configuration settings. 

Calibrate A/D 

The Analog to Digital (A/D) inputs on FlashScan are opto-isolated from the main 
circuit board. The opto-isolators can introduce unwanted offsets into the A/D 
conversion process. To compensate for any unwanted offsets, FlashScan's A/D 
inputs may be re-calibrated if and when required. 

Pre-requisites 

A voltage source capable of providing two different, stable voltages in the range 0-
5V. The low voltage should be in the range 1-2V, the high voltage should be in the 
range 3-5V.  

Procedure  

1. Enter the low millivolts that will be supplied from the external power source 
in the "Low (mV)" field.  

2. Enter the high millivolts that will be supplied from the external power 
source in the "High (mV)" field.  

3. Check the checkbox of each A/D input that is to be recalibrated.  
4. Apply the low voltage to all A/D inputs that have been checked.  
5. Click the [Initialize] button to record the low voltage.  
6. Apply the high voltage to all A/D inputs that have been checked.  
7. Click the [Calibrate] button to calibrate the A/D inputs based on the low and 

high voltages supplied.  
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You can verify the calibration by checking the "Display Data" checkbox, 
applying different voltages and observing the received voltages in the [mV] 
column.  

Existing Factor/Offset values can be displayed by selecting the [Get 
Factor/Offset] button. 

Explanation of Calibration Values  

The raw AD value is a count in the range 0..1023 where 0=0mV and 
1023=5000mV. To convert from AD counts to millivolts, including the calibration 
factor and offset, the following formula is applied:  

mV=(AD*factor+offset)*5000/1023, which is the same as 
mV=(AD*factor+offset)*4.8875855  

[Info] displays the Calibrate A/D procedural information. 

[Restore] restores changes to the installation defaults. 

Firmware 

Displays the FlashScan/AutoCal Boot block and Firmware for the connected 
device. 

If multiple devices are connected (i.e. a FlashScan and an AutoCal), you must 
manually select one or the other device in the list to see/update that device’s boot 
block or firmware version. 

Where outdated boot block or firmware is detected, an option to update boot block 
and/or firmware to the latest version will be displayed. 

[Devices] refreshes device connection status and boot block/firmware version 
numbers. 

Licensing 

FlashScan/AutoCal 

The FlashScan/AutoCal tab allows tuners to manage AutoCal Linking/Unlinking 
and AutoCal VIN slot limits either by connecting both FlashScan and AutoCal to 
the PC, or by connecting FlashScan to the PC and generating remote codes for 
the AutoCal customer to apply to their device.  

Link/Unlink FlashScan to AutoCal 

To be able to create tunes for your customers’ AutoCal devices, you must link the 
AutoCal to your FlashScan.  

There are two ways to link an AutoCal device to your FlashScan. 

1. Physically Link/Unlink AutoCal.  

With both FlashScan and AutoCal connected, select the [Link] option.  Once 
FlashScan and AutoCal are linked, they can be unlinked by using the [Unlink] 
option. 

The "Can self-sign" option is available when physically linking AutoCal. It 
allows the AutoCal device to save any file that it reads from any controller as 
if it had been saved by you using the "Save for AutoCal" option. 

2. Remotely Link/Unlink AutoCal. 
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With FlashScan connected, select the [Generate Remote-Link Code] or 
[Generate Remote-Unlink Code] option from the drop down on the Link 
button. 

Enter Remote AutoCal’s Serial number and select OK. 

Copy Activation instructions and code and send to your AutoCal customer. 

Maximum VIN Slots 

Tuners can manage the number of available VIN slots they wish their AutoCal 
devices to hold.  AutoCals will ship with a default maximum VIN slot count set to 1.  
AutoCal V3 is configurable to a capacity of 600, AutoCal V2 is configurable to a 
capacity of 221. 

VIN slot limits can be changed to any value between 1 and maximum capacity.  If 
the VIN slot limit is already greater than 1, the VIN slot limit can only be decreased 
to a value greater than or equal to the number of VIN slots already installed on the 
AutoCal device. 

To change VIN slot limits AutoCal must first be linked to FlashScan.  Only the 
FlashScan that provided the link can be used to change the maximum VIN slots. 

There are 2 ways to change the maximum VIN slots for AutoCal. 

1. Physically change Max VIN Slots 

With both FlashScan and AutoCal connected, select the [Max VIN Slots] 
option.  Enter Maximum VIN slots. 

2. Remotely change Maximum VIN slots 

With FlashScan connected, select the [Generate Remote-Link Code] or 
[Generate Remote-Unlink Code] option from the drop down on the Link 
button. 

Enter Remote AutoCal’s Serial number, Max VIN slots and select OK. 

Copy Activation instructions and code and send to your AutoCal customer. 

V1->V2 Upgrade 

This option is used where users have purchased the FlashScan V1 to FlashScan 
V2 Upgrade option and have received their FlashScan V2 product and upgrade 
codes. 

Trace Files 

Allows users to configure trace file settings for EFILive V8 applications. Trace files 
are saved in the folder: \My Documents\EFILive\V8\Trace 

Diagnostic tracing is enabled by default but can be activated/deactivated by 
selecting the Enable Diagnostic Tracing checkbox. Users can set the maximum 
trace size and automatic deletion of trace files after a specific number of days. 

Read/Flash trace files are saved using the following naming convention: 

YYYYMMDD_HHNNSS_T_CCC.htx 

Where: 

• YYYYMMDD: is the year, month and day that the trace was recorded. 

• HHNNSS: is the hour, minute and second that the trace was recorded. 

• T: is the mode and is one of R=Read F=Full-Flash W=Cal-Flash. 
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• CCC: Is the controller type 

• htx: is the file extension. 

[Clear Trace] clears current trace file information from PC memory. 

[Save Trace] saves current trace file information from PC memory. 

[Delete All] moves all trace files in the trace folder to the recycle bin. 

[Show Files] opens the specified folder to view the list of saved trace files. 

[Restore] restores changes to the installation defaults. 

[Cancel] cancels changes made, but not yet saved to diagnostic trace file settings. 

[Apply] saves changes made to diagnostic trace file settings. 

 

See Diagnostic Trace Files in Appendix D for information about other 
types of logging/tracing options. 

LCD Capture 

LCD capture takes an image of the connected FlashScan’s screen display.  This 
option is not available for AutoCal. 

[Restore] restores changes to the installation defaults. 

[Copy] copies the imaged displayed to the clipboard.  [Save] saves the captured 
LCD image in *.png file format. 

[Capture] captures LCD image from the connected FlashScan. 

About 

Displays the EFILive Scan and Tune version number, USB driver version and USB 
library version. 
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Appendix A 
Command Line Parameters 

Command Line Options 

The EFILive Scan and Tune software can be started using various command line 
options. The command line options allow shortcuts to be created that can be used 
to start the software and automatically select one of the main menu options. 

/Scan <filename> 

Automatically opens the Scan window and displays the named log file. 

/Tune <filename> 

Automatically opens the Tune window and displays the named tune file. 

/DTC 

Automatically opens the OBD window. 

/BBX <filename> 

Automatically opens the Black Box Configuration window. 

/Dev <filename> 

Automatically opens the Device Settings window and displays the named settings 
file. 

/Lic 

Automatically opens the Licenses window. 

/Tool 

Automatically opens the Tools window. 

Command Line Interface (CLI) 

The EFILive Command Line Interface application (CLI) provides tuners with a way 
to automate the following tasks using the Windows command line or Windows 
batch files: 

• Program FlashScan/AutoCal device settings; 

• Program black box scan and tune options; 

• Format the FlashScan/AutoCal file systems;  

• Copy tune files to FlashScan/AutoCal; 

As well as automation, the CLI also supports gang-programming.  Gang-
programming allows up to five devices to be programmed simultaneously. 

The EFILive_CmdLine.exe file is included within the EFILive V8 software 
download.  Refer to the EFILive Command Line Reference.pdf for documentation. 

 

http://content.efilive.com/documents/EFILive%20Command%20Line%20Reference.pdf
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Appendix B 
Files and Folders 

Files and Folders 

Documents Folder 

The EFILive software stores data files in the \My Documents\EFILive\V8 folder of 
the user who installed the software. 

Installation Folder 

By default the EFILive software installs the application files into the folder: 

For Windows 32 bit systems: C:\Program Files\EFILive\V8 

For Windows 64 bit systems: C:\Program Files (x86)\EFILive\V8 

However, you may choose any folder in which to install the EFILive software 
during the installation process. 
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Appendix C 
International Settings 

Units 

Metric 

All numeric data managed by EFILive applications is stored and computed in 
metric units. 

Custom 

Numeric data may be displayed in either the default metric units or in user defined 
custom units. Custom units are usually define as US Customary units, such as psi, 
mph and lbs. 

Custom units can be created and managed using: Properties->General->Units. 

See the Units section of this document for more info. 

Display Formats 

Dates 

Two date formats are supported, European style dates that display the day first 
like this: 15 Jan 2012, and US style dates that display the month first like this Jan 
15, 2012. 

Numbers 

Two number formats are supported, European style numbers that display like this: 
12.345,67, and US style numbers that display like this 12,345.67. 

Numeric and date formats may be configured independently for Display, Clipboard 
and Import/Export duties using: Properties->General->Locale. 

See the Locale section of this document for more info. 

Language 

Translations 

The EFILive applications have been released in English; they have not been 
translated into any other language. 
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Appendix D 
Troubleshooting 

Error Messages 

Error Message Document 

Error numbers are listed in the EFILive Error Codes.pdf document that can be 
accessed via: Start->All Programs->EFILive->V8->Documents->EFILive Error 
Codes. 

Error codes and messages can be “looked up” in the EFILive V8 software using 
the option [F8: Tools]->[F8: Error Codes]. 

Reporting Problems 

Obtaining Support Information 

If you purchased your FlashScan or AutoCal device from an EFILive dealer, your 
first contact for obtaining support should be that dealer. The dealer can direct you 
to the appropriate resources to help resolve problems using the EFILive software 
and/or FlashScan/AutoCal devices. 

If you purchased your FlashScan or AutoCal device directly from EFILive you may 
visit our web site and select one or more of the appropriate Support menu options. 

Creating a Support Ticket 

The EFILive Helpdesk is a web based application. The EFILive Helpdesk can be 
accessed here: http://service.efilive.com/ 

When you first visit the EFILive Helpdesk you will be presented with a screen 
similar to the image below. 

 

The EFILive Service Desk Username and Password are shared with the EFILive 
store. If you already have an account on the EFILive store, enter the same 
Username and Password in the Login to Your Account section. 

http://service.efilive.com/
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If you do not currently have an EFILive store account you can sign up as a new 
user or create a ticket as a guest.  

Asking a Question 

Use the Contact Us links to create a support ticket.  Please provide as much 
information as possible for our support team to assist with your request. 

Diagnostic Trace Files 

Read/Flash Trace Files 

When the EFILive application reads or flashes a controller the details of the 
read/flash process may be saved in trace files for diagnostic purposes.  

If you experience difficulty reading or flashing a controller, EFILive Support may 
request that you send the appropriate trace file to EFILive. 

Trace files are created on your PC or laptop in the folder: \My 
Documents\EFILive\V8\Trace and are named using the following naming 
convention: 

YYYYMMDD_HHNNSS_T_CCC.htx 

Where: 

• YYYMMDD: is the year, month and day that the trace was recorded. 

• hhnnss: is the hour, minute and second that the trace was recorded. 

• T: is the mode and is one of 
R=Read 
F=Full-Flash 
W=Cal-Flash. 

• CCC: is the controller type 

• htx: is the file extension. 

An example trace file name might be: 20110604_214334_F E38.htx which 
contains a trace of a Flash attempt on an E38 controller on June 04, 2011 at 
09:43:34pm. 

Trace files can be managed using the EFILive Control Panel application on the 
[F8: Trace] tab page. 
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Application Log Files 

Each EFILive application can be forced to create a log file in which important 
information about the state and progress of the application is saved. To force an 
application to create and maintain a log file, hold down the Ctrl key while starting 
the application. 

Log files are created in the folder: \My Documents\EFILive\V8\Trace with a 
filename that matches the application being logged. The files contain plain text that 
can be read using any text editor including the Windows Notepad program. 

Each diagnostic message is stored on a separate line and consists of three pipe “|” 
delimited fields. 

1. Timestamp 
2. Process ID 
3. Message 

A typical application log file will contain information like this: 
10:21:37.083|5008|Version: 8.2.2 Build 208 

10:21:37.083|5008|Create Form: fMain_ScanAndTune 

10:21:37.084|5008|Opened INI file: D:\EFILive Production\V8\EFILiveSystem.ini 

10:21:37.085|5008|Opened INI file: D:\Blackys_Documents\EFILive\V8\Config\EFILiveScanAndTuneLayout.ini 

10:21:37.086|5008|Opened INI file: D:\Blackys_Documents\EFILive\V8\Config\EFILiveScanAndTune.ini 

10:21:37.087|5008|Opened INI file: D:\EFILive Production\V8\EFILiveCalculatedPids.ini 

10:21:37.087|5008|Opened INI file: D:\Blackys_Documents\EFILive\V8\Config\UserCalculatedPids.ini 

10:21:37.149|5008|Opened internal INI file 

10:21:37.149|5008|Opened internal INI file 

10:21:37.152|5008|Closed internal INI file 

10:21:37.152|5008|Closed internal INI file 

10:21:39.395|5008|Closed INI file: D:\EFILive Production\V8\EFILiveSystem.ini 

10:21:39.397|5008|Closed INI file: D:\Blackys_Documents\EFILive\V8\Config\EFILiveScanAndTuneLayout.ini 

10:21:39.398|5008|Closed INI file: D:\Blackys_Documents\EFILive\V8\Config\EFILiveScanAndTune.ini 

10:21:39.399|5008|Closed INI file: D:\EFILive Production\V8\EFILiveCalculatedPids.ini 

10:21:39.400|5008|Closed INI file: D:\Blackys_Documents\EFILive\V8\Config\UserCalculatedPids.ini 

10:21:39.401|5008|Destroy Form: fMain_ScanAndTune 

FlashScan/AutoCal Trace Files 

The option to automatically save a trace file onto FlashScan or AutoCal if the read 
or flash fails using BBX is enabled by default.  This option is managed in the [F6: 
Devices] -> [F7: BBX] window. 

Trace files can be manually saved at the end of a failed process using: 

FlashScan/AutoCal V3: Navigate to Scan Tool -> F3 Scan Options -> F1 Save 
Trace File. 

FlashScan V2: Navigate to F1 Scan Tool -> F3 Scan Options -> F1 Save Trace 
File. 

AutoCal V2 (Simple Menu): Save Trace File. 

AutoCal V2 (Advanced Menu): Scan Tool -> Save Trace File. 

The FlashScan and AutoCal devices maintain an internal buffer of the most recent 
messages sent to and received from the vehicle. That buffer is stored in RAM 
memory and is wiped clean each time the device is powered off or rebooted. 
Therefore you MUST save the trace file before powering off or rebooting the 
device. 

The support file will be saved in the "Scan" folder on the device; 

FlashScan/AutoCal V3 trace files are named using the following naming 
convention: 

yyyymmdd_hhnnss_<desc>.xalm, where: 

• yyyymmdd: is the year, month and day that the trace was recorded. 

• hhnnss: is the hour, minute and second that the trace was recorded. 
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• <desc>: is the description where; 
o “User” means user generated trace files 
o “xxx._x_$xxxx” identifies the 3 character controller ID, the 

communication process upload/download, and the 4 digit error 
code. 

• xalm: is the file extension.  

The trace file can be retrieved by connecting FlashScan/AutoCal V3 to your 
PC and navigating to Options-> F2: File System -> F3: USB Thumb Drive on 
the device to open FlashScan/AutoCal V3 in Windows Explorer. 

FlashScan/AutoCal V2 trace files will be named USR_xxxx.efx, where xxxx is 
the unique file counter number and can be retrieved using the V8 EFILive 
Explorer program. 
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Appendix E 
Cummins HD File Conversion Tool 

XCal File Conversion  

To assist tuners who have existing Cummins HD tune file libraries in the *.xcal file 
format, EFILive has developed a conversion tool called “EFILive XCal” to convert 
these tune files for use in EFILive software.  

*.xcal files are essentially .hex files but use the extension of “*.xcal”. 

*Sometimes the xcal file extension might be *.00, *.01, *.02, *.03, etc, in these 
cases we refer to them as .0? files. 

This document is intended to provide EFILive tuners with an overview of the file 
conversion process. 

EFILive XCal is a standalone program that is included with the EFILive V8 
software installation. The EFILive V8 software installation is governed by the 
EFILive Terms and Conditions and the EFILive End User License Agreement. 

The EFILive XCal application file (EFILive_xcal.exe) may be copied to and used 
on any other device, including but not limited to external thumb drives. 

Refer to the Cummins HD File Conversion Guide.pdf for documentation. 

 

 

http://content.efilive.com/documents/Cummins%20HD%20File%20Conversion%20Guide.pdf

